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In this section...

“Introduction” on page 1-2
“Optimization Functions” on page 1-2

“Optimization Tool GUI” on page 1-3

Introduction

Optimization Toolbox software extends the capability of the MATLAB®
numeric computing environment. The software includes functions for many
types of optimization including

¢ Unconstrained nonlinear minimization

¢ Constrained nonlinear minimization, including semi-infinite minimization

problems

Quadratic and linear programming
Nonlinear least-squares and curve fitting
Constrained linear least squares

Sparse and structured large-scale problems, including linear programming
and constrained nonlinear minimization

Multiobjective optimization, including goal attainment problems and
minimax problems

The toolbox also includes functions for solving nonlinear systems of equations.

Optimization Functions

Most toolbox functions are MATLAB M-files, made up of MATLAB statements
that implement specialized optimization algorithms. You can view the
MATLAB code for these functions using the statement

type function_name




Product Overview

You can extend the capabilities of Optimization Toolbox software by writing
your own M-files, or by using the software in combination with other
toolboxes, or with the MATLAB or Simulink® environments.

Optimization Tool GUI

Optimization Tool (optimtool) is a graphical user interface (GUI) for
selecting a toolbox function, specifying optimization options, and running
optimizations. It provides a convenient interface for all optimization routines,
including those from Genetic Algorithm and Direct Search Toolbox™ software,
which is licensed separately.

Optimization Tool makes it easy to

¢ Define and modify problems quickly

¢ Use the correct syntax for optimization functions

® Import and export from the MATLAB workspace

® Generate code containing your configuration for a solver and options

¢ Change parameters of an optimization during the execution of certain
Genetic Algorithm and Direct Search Toolbox functions

1-3
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Example: Nonlinear Constrained Minimization

In this section...

“Problem Formulation: Rosenbrock’s Function” on page 1-4
“Defining the Problem in Toolbox Syntax” on page 1-5

“Running the Optimization” on page 1-7

“Interpreting the Result” on page 1-12

Problem Formulation: Rosenbrock’s Function

Consider the problem of minimizing Rosenbrock’s function

2
f(x)=100(xy =f | +(1-xp)?,
over the unit disk, i.e., the disk of radius 1 centered at the origin. In other

words, find x that minimizes the function f(x) over the set x% + x% <1. This
problem is a minimization of a nonlinear function with a nonlinear constraint.

Note Rosenbrock’s function is a standard test function in optimization. It
has a unique minimum value of 0 attained at the point (1,1). Finding the
minimum is a challenge for some algorithms since it has a shallow minimum
inside a deeply curved valley.

Here are two view of Rosenbrock’s function in the unit disk. The vertical
axis is log-scaled; in other words, the plot shows log(1 + f(x)). Contour lines
lie beneath the surface plot.



Example: Nonlinear Constrained Minimization

Rosenbrock’s function, log-scaled: two views.

The function f(x) is called the objective function. This is the function you wish

to minimize. The inequality x12 + x% <1 is called a constraint. Constraints
limit the set of x over which you may search for a minimum. You may have
any number of constraints, which may be inequalities or equations.

All Optimization Toolbox optimization functions minimize an objective
function. To maximize a function f, apply an optimization routine to minimize

.

Defining the Problem in Toolbox Syntax

To use Optimization Toolbox software, you need to

1 Define your objective function in the MATLAB language, as an M-file or
anonymous function. This example will use an M-file.

1-5



1 Getting Started

1-6

2 Define your constraint(s) as a separate M-file or anonymous function.

M-file for Objective Function

An M-file is a text file containing MATLAB commands with the extension .m.
Create a new M-file in any text editor, or use the built-in MATLAB Editor as
follows:

1 At the command line type

edit rosenbrock

The MATLAB Editor opens.
2 In the editor type:

function f = rosenbrock(x)
f = 100*(x(2) - x(1)"2)"2 + (1 - x(1))"2;

3 Save the file by selecting File > Save.

M-File for Constraint Function
Constraint functions must be formulated so that they are in the form

c(x) <0 or ceq(x) = 0. The constraint x12 + x% <1 needs to be reformulated as

x% + x% —1<0 in order to have the correct syntax.

Furthermore, toolbox functions that accept nonlinear constraints need to
have both equality and inequality constraints defined. In this example there
is only an inequality constraint, so you must pass an empty array [ ] as
the equality constraint function ceq.

With these considerations in mind, write a function M-file for the nonlinear
constraint:

1 Create a file named unitdisk.m containing the following code:

function [c, ceq] = unitdisk(x)
c =Xx(1)"2 + x(2)"2 - 1;
ceq = [ 1;
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2 Save the file unitdisk.m.

Running the Optimization

There are two ways to run the optimization:

e Using the “Optimization Tool” on page 1-7 Graphical User Interface (GUI)

¢ Using command line functions; see “Minimizing at the Command Line”
on page 1-11.
Optimization Tool

1 Start the Optimization Tool by typing optimtool at the command line.
The following GUI opens.
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File Help

). Optimization Tool

Problem Setup and Results

Options

Quick Reference

Salver: I fmincon - Constrained nonlinear minimization - |

Algorithm: I Trust region reflective

[=] Stopping criteria

[-]

Prablem

Objective function: I

=
[
=l

Derivatives: I Approximated by solver

Start paink: I

Constraints:

Linear inequalities: A by I
Linear equalities: Aeq beq: I
Bounds: Upper: I

Monlinear constraint function

Derivatives:

Lower: I

Approximated by solver j

~Run solver and view results

Skart | Pause | Stop |

Current iteration: I Clear Results |

Max iterations: * Use default: 400

% = Specify: I

Max Function evaluations: & Use default: 100*numberOFVariables

~ Specify: I

X kolerance: @ Use default: 1=-06

~ Specify: I

Function tolerance: @ Use default: 1=-06

~ Specify: I

Monlinear constraint tolerance: % Use default: 12-6

~ Specify: I

SQP constraint tolerance: (* Use default: 126

" Specify: I

Unboundedness threshold: % Use default; -1220

" Specify: I

[=] Function value check:

I~ Errar if user-supplied function returns Inf, NaM or complex

[= User-supplied derivatives

I~ |Validate user-supplied derivatives

Hessian sparsity pattern: % Use default: sparse{ones{numberOfyvariables))

= Specify: I

Hessian mulkiply Function: ) Use default: Mo mulkiply Function

Kl n

Minimurn perturbation: Use defaulk: 12-8

= Specify: |

Maximum perturbation: ' Use default; 0.1

= Specify: I

Type: I forward differences

=

— " Specify: |
Final point: [=] Approximated derivatives |
L Finite differences:

Il

fmincon Solver
Find a minimum of a
constrained nonlinear
multivariable function

Click to expand the
section below
corresponding to your
task.

Problem Setup
b Solver and Algorithm

b Function to Minimize
» Constraints

b Run solver and view
results

Options
b Stopping criteria

b Function value check

b User-supplied
derivatives

b Approximated
derivatives

b Algorithm settings

b Inner iteration stopping
criteria

b Plot functions
b Output function

» Display to command
window

More Information
b Optimization Tool
Chapter

b Function Equivalent

For more information about this tool, see Chapter 3, “Optimization Tool”.
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2 The default Solver fmincon - Constrained nonlinear minimization
1s selected. This solver is appropriate for this problem, since Rosenbrock’s
function is nonlinear, and the problem has a constraint. For more
information about how to choose a solver, see “Choosing a Solver” on page

2-21.

3 In the Algorithm pop-up menu choose Active set—the default Trust
region reflective solver doesn’t handle nonlinear constraints.

4 For Objective function type @rosenbrock. The @ character indicates that
this is a function handle of the M-file rosenbrock.m.

5 For Start point type [0 0]. This is the initial point where fmincon begins

its search for a minimum.

6 For Nonlinear constraint function type @unitdisk, the function handle

of unitdisk.m.

Your Problem Setup and Results pane should match this figure.

Salver:

I fmincan - Canstrained nonlinear minimizakion

[

Algorithm: I Active set

~Problem

Objeckive function: I @rosenbraock

Derivatives: I Approximated by solver

[
=l
[

Start paint: |[o o]

Consktrainks:

Linear inequalities: A I
Aeq: I

Linear equalities;

Bounds:

Lower: I Upper: I

b: I—
beq: I—

Maorlingar conskraint Funckion: I@unitdisk

Derivatives:

I Approximated by solver

[

1-9
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7 In the Options pane (center bottom), select iterative in the Level of
display pop-up menu. (If you don’t see the option, click H Display to
command window.) This shows the progress of fmincon in the command
window.

[=] Display ko command windaw

Level of display:

8 Click Start under Run solver and view results.

Run solver and view results

Skart N Fause | Stop |

Current iteration: I Clear Results

The following message appears in the box below the Start button:

Optimization running.

Optimization terminated.

Objective function value: 0.04567571111479972

Optimization terminated: magnitude of directional derivative in search
direction less than 2*options.TolFun and maximum constraint violation
is less than options.TolCon.

Your objective function value may differ slightly, depending on your computer
system and version of Optimization Toolbox software.

The message tells you that:

® The search for a constrained optimum ended because the derivative of the
objective function is nearly 0 in directions allowed by the constraint.

® The constraint is very nearly satisfied.

The minimizer x appears under Final point.
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Final poink:

1 £
0,786 0.613

Minimizing at the Command Line
You can run the same optimization from the command line, as follows.

1 Create an options structure to choose iterative display and the active-set
algorithm:

options = optimset('Display',‘'iter','Algorithm', 'active-set');

2 Run the fmincon solver with the structure options, reporting both the
location x of the minimizer, and value fval attained by the objective
function:

[x,fval] = fmincon(@rosenbrock,[0 0],...
[1,01,01,01,[1,[1,@unitdisk,options)

The six sets of empty brackets represent optional constraints that are not
being used in this example. See the fmincon function reference pages for
the syntax.

MATLAB outputs a table of iterations, and the results of the optimization:

Optimization terminated: magnitude of directional derivative in search
direction less than 2*options.TolFun and maximum constraint violation
is less than options.TolCon.

No active inequalities.

0.7864 0.6177

fval =
0.0457

The message tells you that the search for a constrained optimum ended

because the derivative of the objective function is nearly 0 in directions
allowed by the constraint, and that the constraint is very nearly satisfied.

1-11
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Interpreting the Result

The iteration table in the command window shows how MATLAB searched for
the minimum value of Rosenbrock’s function in the unit disk. This table is

the same whether you use Optimization Tool or the command line. MATLAB
reports the minimization as follows:

Iter F-count

0 3
1 9
2 16
3 21
4 24
5 27
6 30
7 33
8 36
9 40
10 43
11 47
12 51
13 55
14 59
15 63
16 67
17 71
18 75
19 79
20 83

OO O O O O o o o o o o o

o O O o o o o o

f(x)

1
.953127
.808445
.462347
.340677
.300877
.261949
.164971
.110766

.0750932

.0580976

.0482475

.0464333

.0459217

.0457652

.0457117

.0456912

.0456825

.0456785

.0456766

.0456757

Max
constraint
-1
-0.9375
-0.8601
-0.836
-0.7969
-0.7193
-0.6783
-0.4972
-0.3427
-0.1592
-0.007608
-0.003783
-0.001888
-0.0009431
-0.0004713
-0.0002356
-0.0001178
-5.889e-005
-2.944e-005
-1.472e-005
-7.361e-006

Line search Directional First-order

steplength

0.125

0.0625

0.25

o O O O O O o o o o
a oo oo o o o o o o o

1
1
1

derivative

9.5
0.715
1.83
-0.0409
0.0087
-0.0348
-0.0632
-0.0272
0.00514
0.00908
-0.0122
0.00257

-0.000759

-0.000247

-9.
-3.
-1
-7
-3.
-1

04e-005
69e-005

.64e-005
.67e-006

71e-006

.82e-006

optimality Procedure

12.5

12.4

5.

15

0.811

3.
3.
2.

2.
3.

1

72
02
29

2
41
19

.41

0.726

0.362

0.181

0.0906

0.0453

0.0226

0.0113

0.00566

0.00283

Hessian
Hessian
Hessian
Hessian
Hessian

Hessian

modified
modified
modified
modified
modified

modified

This table might differ from yours depending on toolbox version and computing
platform. The following description applies to the table as displayed.

e The first column, labeled Iter, is the iteration number from 0 to 20.

fmincon took 20 iterations to converge.

® The second column, labeled F-count, reports the cumulative number
of times Rosenbrock’s function was evaluated. The final row shows an
F-count of 83, indicating that fmincon evaluated Rosenbrock’s function 83

times in the process of finding a minimum.
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® The third column, labeled f (x), displays the value of the objective function.
The final value, 0.0456757, is the minimum that is reported in the
Optimization Tool Run solver and view results box, and at the end of
the exit message in the command window.

® The fourth column, Max constraint, goes from a value of —1 at the initial
value, to very nearly 0, —7.361e—006, at the final iteration. This column
shows the value of the constraint function unitdisk at each iteration. Since

the value of unitdisk was nearly O at the final iteration, x12 + x% =1 there.

The other columns of the iteration table are described in “Displaying Iterative
Output” on page 2-47.
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¢ “Introduction to Optimization Toolbox Solvers” on page 2-2

* “Writing Objective Functions” on page 2-4

® “Writing Constraints” on page 2-11

¢ “Passing Extra Parameters” on page 2-17

¢ “Choosing a Solver” on page 2-21

® “Solver Inputs and Outputs” on page 2-27

e “Default Options Settings” on page 2-41

® “Displaying Iterative Output” on page 2-47

e “Typical Problems and How to Deal with Them” on page 2-54
® “Local vs. Global Optima” on page 2-57

e “Reference” on page 2-62
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Introduction to Optimization Toolbox Solvers

There are four general categories of Optimization Toolbox solvers:

Minimizers

This group of solvers attempts to find a local minimum of the objective
function near a starting point x0. They address problems of unconstrained
optimization, linear programming, quadratic programming, and general
nonlinear programming.

Multiobjective minimizers

This group of solvers attempts to either minimize the maximum value of
a set of functions (fminimax), or to find a location where a collection of
functions is below some prespecified values (fgoalattain).

Equation solvers

This group of solvers attempts to find a solution to a scalar- or vector-valued
nonlinear equation f(x) = 0 near a starting point x0. Equation-solving can
be considered a form of optimization because it is equivalent to finding

the minimum norm of f(x) near x0.

Least-Squares (curve-fitting) solvers

This group of solvers attempts to minimize a sum of squares. This type of
problem frequently arises in fitting a model to data. The solvers address
problems of finding nonnegative solutions, bounded or linearly constrained
solutions, and fitting parameterized nonlinear models to data.

For more information see “Problems Handled by Optimization Toolbox
Functions” on page 2-21. See “Optimization Decision Table” on page 2-24 for
aid in choosing among solvers for minimization.

Minimizers formulate optimization problems in the form

min f(x),

possibly subject to constraints. f(x) is called an objective function. In general,
f(x) is a scalar function of type double, and x is a vector or scalar of type
double. However, multiobjective optimization, equation solving, and some
sum-of-squares minimizers, can have vector or matrix objective functions F(x)
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of type double. To use Optimization Toolbox solvers for maximization instead
of minimization, see “Maximizing an Objective” on page 2-9.

Write the objective function for a solver in the form of an M-file or anonymous
function handle. You can supply a gradient Vf(x) for many solvers, and you
can supply a Hessian for several solvers. See “Writing Objective Functions”
on page 2-4. Constraints have a special form, as described in “Writing
Constraints” on page 2-11.
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In this section...

“Writing Objective Functions” on page 2-4
“Jacobians of Vector and Matrix Objective Functions” on page 2-6
“Anonymous Function Objectives” on page 2-9

“Maximizing an Objective” on page 2-9

Writing Objective Functions

This section relates to scalar-valued objective functions. For vector-valued
or matrix-valued objective functions, see “Jacobians of Vector and Matrix
Objective Functions” on page 2-6. For information on how to include extra
parameters, see “Passing Extra Parameters” on page 2-17.

An objective function M-file can return one, two, or three outputs. It can
return:

® A single double-precision number, representing the value of f(x)

¢ Both f(x) and its gradient Vf(x)

e All three of f(x), Vf(x), and the Hessian matrix H(x)=62f/6xi6xj

You are not required to provide a gradient for some solvers, and you are
never required to provide a Hessian, but providing one or both can lead to
faster execution and more reliable answers. If you do not provide a gradient

or Hessian, solvers may attempt to estimate them using finite difference
approximations or other numerical schemes.

Some solvers do not use gradient or Hessian information. You should
“conditionalize” an M-file so that it returns just what is needed:

® f(x) alone

¢ Both f(x) and Vf(x)

e All three of f(x), Vf(x), and H(x)
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For example, consider Rosenbrock’s function

2
Fx)=100(xy —f | +(1-xp)?,
which 1s described and plotted in “Example: Nonlinear Constrained

Minimization” on page 1-4. The gradient of f(x) is

~400(x - 7 )21 ~2(1-11)
Vf(x)= )
200 (xy -7 )

and the Hessian H(x) is

1200x% —400x9 +2 4002
~400x; 200 |

H(x) =

Function rosenboth returns the value of Rosenbrock’s function in f, the
gradient in g, and the Hessian in H if required:

function [f g H] = rosenboth(x)
% Calculate objective f
f = 100*(x(2) - x(1)"2)"2 + (1-x(1))"2;

if nargout > 1 % gradient required
g = [-400*(x(2)-x(1)"2)*x(1)-2*(1-x(1));
200* (x(2)-x(1)"2)1;

if nargout > 2 % Hessian required
H = [1200*x(1)"2-400*x(2)+2, -400*x(1);
-400*x (1), 200];
end

end

nargout checks the number of arguments that a calling function specifies; see
“Checking the Number of Input Arguments” in the MATLAB Programming
Fundamentals documentation.
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The solver fminunc, designed for unconstrained optimization, allows you
to minimize Rosenbrock’s function. Tell fminunc to use the gradient and
Hessian by setting options:

options = optimset('GradObj','on', 'Hessian','on');
Run fminunc starting at [-1, 2]:

[x fval] = fminunc(@rosenboth, [-1; 2], options)
Optimization terminated: first-order optimality less than OPTIONS.TolFun,
and no negative/zero curvature detected in trust region model.
X =
1.0000
1.0000
fval =
1.9310e-017

Jacobians of Vector and Matrix Objective Functions

Some solvers, such as fsolve and 1sqcurvefit, can have objective functions
that are vectors or matrices. The only difference in usage between these
types of objective functions and scalar objective functions is the way to write
their derivatives. The first-order partial derivatives of a vector-valued or
matrix-valued function is called a Jacobian; the first-order partial derivatives
of a scalar function is called a gradient.

Jacobians of Vector Functions

If x represents a vector of independent variables, and F(x) is the vector
function, the Jacobian J(x) is defined as

T () = 2D

8xj

If F has m components, and x has k components, J is a m-by-k matrix.

For example, if

2
Flx) = . X1 tXoX3 ’
sin (x; +2x9 —3x3)
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then J(x) 1s

J(x)

Jacobians of Matrix Functions

X2
B [cos(xl +2x9 —3x3) 2cos(xq +2x9 —3x3) —3cos(xq +2x9 —3x3)}'

The Jacobian of a matrix F(x) is defined by changing the matrix to a vector,

column by column. For example, the matrix

is rewritten as a vector f:

The Jacobian of F'is defined as the Jacobian of f,

oJ s

Fi
F=|Fy
F3,

F39

I

v BxJ '

If F'is an m-by-n matrix, and x is a k-vector, the Jacobian is a mn-by-k matrix.

For example, if

F(x) =|5xg — xf
4—x§

the Jacobian of Fis
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X9 x
—4x13 5
0 —2x9
)= 3x12 6x9
—x9 / x% 1/x;
33c12 —4x§ ]

Jacobians with Matrix-Valued Independent Variables

If x 1s a matrix, the Jacobian of F(x) is defined by changing the matrix x to a
vector, column by column. For example, if

X X
X = [ 11 12:|’
X21  X22

then the gradient is defined in terms of the vector

With

Fi1 Fpo
F=\Fy Fy|
F31 F3o

and f the vector form of F' as above, the Jacobian of F(X) is defined to be the
Jacobian of f(x):

sy

So, for example,
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of (5) _ dFyy

IS _ 1 ang g4 = .
w(2) X9y’ T x4 Xy

If F'is an m-by-n matrix, and x is a j-by-k matrix, the Jacobian is a mn-by-jk
matrix.

J(3,2) =

Anonymous Function Objectives

Anonymous functions are useful for writing simple objective functions,
without gradient or Hessian information. Rosenbrock’s function is simple
enough to write as an anonymous function:

anonrosen = @(x) (100*(x(2) - x(1)*2)*2 + (1 - x(1))"2);

Check that this evaluates correctly at (-1,2):

>> anonrosen([-1 2])
ans =
104

Using anonrosen in fminunc yields the following results:

[x fval] = fminunc(anonrosen, [-1; 2])
Warning: Gradient must be provided for trust-region method;
using line-search method instead.
> In fminunc at 265
Optimization terminated: relative infinity-norm of gradient less than options.TolFun.
X =
1.0000
1.0000
fval =
1.2262e-010

Maximizing an Objective
All solvers are designed to minimize an objective function. If you have a
maximization problem, that is, a problem of the form

max f(x),

then define g(x) = —f(x), and minimize g.

2-9
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For example, to find the maximum of tan(cos(x)) near x = 5, evaluate:

[x fval] = fminunc(@(x)-tan(cos(x)),5)
Warning: Gradient must be provided for trust-region method;
using line-search method instead.

> In fminunc at 265
Optimization terminated: relative infinity-norm of gradient less than options.TolFun.
X =

6.2832
fval =

-1.5574

The maximum 1s 1.5574 (the negative of the reported fval), and occurs at
x = 6.2832. This is correct since, to 5 digits, the maximum is tan(1l) = 1.5574,
which occurs at x = 2 = 6.2832.
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Writing Constraints

In this section...

“Types of Constraints” on page 2-11

“Bound Constraints” on page 2-12

“Linear Inequality Constraints” on page 2-13
“Linear Equality Constraints” on page 2-13

“Nonlinear Constraints” on page 2-14

“An Example Using All Types of Constraints” on page 2-15

Types of Constraints

Optimization Toolbox solvers have special forms for constraints. Constraints
are separated into the following types:

* “Bound Constraints” on page 2-12 — Lower and upper bounds on individual
components: x >/ and x < u.

¢ “Linear Inequality Constraints” on page 2-13 — Ax < b. A is an m-by-n
matrix, which represents m constraints for an n-dimensional vector x. b is
m-dimensional.

¢ “Linear Equality Constraints” on page 2-13 — Aeq «x = beq. This is a system
of equations.

¢ “Nonlinear Constraints” on page 2-14 — c(x) < 0 and ceq(x) = 0. Both ¢ and
ceq are scalars or vectors representing several constraints.

Optimization Toolbox functions assume that inequality constraints are of the
form c;(x) < 0 or A x < b. Greater-than constraints are expressed as less-than
constraints by multiplying them by —1. For example, a constraint of the form
c¢,(x) > 0 is equivalent to the constraint —c,(x) < 0. A constraint of the form

A x> b is equivalent to the constraint —A x <-b. For more information, see
“Linear Inequality Constraints” on page 2-13 and “Nonlinear Constraints”
on page 2-14.

You can sometimes write constraints in a variety of ways. To make the best
use of the solvers, use the lowest numbered constraints possible:

2-11
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1 Bounds

2 Linear equalities

3 Linear inequalities
4 Nonlinear equalities

5 Nonlinear inequalities

For example, with a constraint 5 x < 20, use a bound x < 4 instead of a linear
inequality or nonlinear inequality.

For information on how to pass extra parameters to constraint functions, see
“Passing Extra Parameters” on page 2-17.

Bound Constraints

Lower and upper bounds on the components of the vector x. You need not give
gradients for this type of constraint; solvers calculate them automatically.
Bounds do not affect Hessians.

If you know bounds on the location of your optimum, then you may obtain
faster and more reliable solutions by explicitly including these bounds in your
problem formulation.

Bounds are given as vectors, with the same length as x.

e [f a particular component is not bounded below, use —Inf as the bound;
similarly, use Inf if a component is not bounded above.

¢ If you have only bounds of one type (upper or lower), you do not need
to write the other type. For example, if you have no upper bounds, you
do not need to supply a vector of Infs. Also, if only the first m out of n
components are bounded, then you need only supply a vector of length
m containing bounds.

For example, suppose your bounds are:

® x,>8

® x,<3
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Write the constraint vectors as

e | = [-Inf; —Inf; 8]
e 1 = [Inf; 3] or u = [Inf; 3; Inf]

Linear Inequality Constraints

Linear inequality constraints are of the form A x <b. When A is m-by-n, this
represents m constraints on a variable x with n components. You supply the
m-by-n matrix A and the m-component vector b. You do not need to give
gradients for this type of constraint; solvers calculate them automatically.
Linear inequalities do not affect Hessians.

For example, suppose that you have the following linear inequalities as
constraints:

X, tx,<4,
2%~ x> —2,
X=Xy + x— x,> 9.

Here m = 3 and n = 4.

Write these using the following matrix A and vector b:

1 0 1 0

A=l0 -2 1 o]
-1 1 -1 1
4

b=| 2|
-9

Notice that the “greater than” inequalities were first multiplied by —1 in order
to get them into “less than” inequality form.

Linear Equality Constraints

Linear equalities are of the form Aeq x = beq. This represents m equations
with n-component vector x. You supply the m-by-n matrix Aeq and the
m-component vector beq. You do not need to give a gradient for this type of
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constraint; solvers calculate them automatically. Linear equalities do not
affect Hessians. The form of this type of constraint is exactly the same as
for “Linear Inequality Constraints” on page 2-13. Equalities rather than
inequalities are implied by the position in the input argument list of the
various solvers.

Nonlinear Constraints

Nonlinear inequality constraints are of the form c(x) < 0, where c is a vector of
constraints, one component for each constraint. Similarly, nonlinear equality
constraints are of the form ceq(x) = 0. If you provide gradients for ¢ and ceq,
your solver may run faster and give more reliable results.

For example, suppose that you have the following inequalities as constraints:

2 2
Xy o«
_1+_2S1,
9 4
X9 lez—l.

Write these constraints in an M-file as follows:

function [c,ceq]=ellipseparabola(x)
% Inside the ellipse bounded by (-3<x<3), (-2<y<2)
% Above the line y=x"2-1

c(1) = (x(1)72)/9 + (x(2)"2)/4 - 1;
c(2) = x(1)"2 - x(2) - 1;

ceq = [];

end

The constraint function returns empty [ ] as the nonlinear equality function.
Nonlinear constraint functions must return both inequality and equality
constraints, even if they do not both exist. Also, both inequalities were put
into < 0 form.

To include gradient information, write a conditionalized function as follows:

function [c,ceq,gradc,gradceq]=ellipseparabola(x)
% Inside the ellipse bounded by (-3<x<3), (-2<y<2)
% Above the line y=x"2-1

(1) = x(1)72/9 + x(2)"2/4 - 1;

o
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c(2) = x(1)"2 - x(2) - 1;
ceq = [1;

if nargout > 2
gradc = [2*x(1)/9, 2*x(1);...
x(2)/2, -1];
gradceq = [1;
end

See “Writing Objective Functions” on page 2-4 for information on
conditionalized gradients. The gradient matrix is of the form

gradchj:[acqya%L

The first column of the gradient matrix is associated with ¢ (1), and the second
column is associated with ¢ (2). This is the transpose of the form of Jacobians.

To have a solver use gradients of nonlinear constraints, you must indicate
that you have supplied them by using optimset:

options=optimset('GradConstr', 'on');
Make sure to pass the options structure to your solver:

[x,fval] = fmincon(@myobj,x0,A,b,Aeq,beq,lb,ub,...
@ellipseparabola,options)

An Example Using All Types of Constraints

This section contains an example of a nonlinear minimization problem with
all possible types of constraints. The objective function is in the subfunction
myobj (x). The nonlinear constraints are in the subfunction myconstr(x).
Gradients are not used in this example.

function fullexample
X0 = [1; 4; 5; 2; 3];

1b = [-Inf; -Inf; O0; -Inf; 1];
ub = [ Inf; Inf; 20];
Aeq = [1 -0.3 0 0 0];
beq = 0;
A=[00 0 -1 0.1
00 O 1 -0.5
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00 -1 0 0.9];
b = [0; 0; 03

[x,fval,exitflag]=fmincon(@myobj,x0,A,b,Aeq,beq,lb,ub,...
@myconstr)

[»)
I I T T T T T T I T T T

function f = myobj(x)
f = 6*x(2)*x(5) + 7*x(1)*x(3) + 3*x(2)"2;

[»)
R I I I i I I e e e e I T

function [c, ceq] = myconstr(x)

c = [x(1) - 0.2*x(2)*x(5) - 71
0.9*x(3) - x(4)"2 - 67];
ceq = 3*x(2)"2*x(5) + 3*x(1)"2*x(3) - 20.875;

Calling fullexample produces the following display in the command window:

fullexample
Warning: Trust-region-reflective method does not currently solve this type of problem,

using active-set (line search) instead.

> In fmincon at 317

In fullexample at 12

Optimization terminated: first-order optimality measure less than options.TolFun

and maximum constraint violation is less than options.TolCon.
Active inequalities (to within options.TolCon = 1e-006):

lower upper ineqlin ineqgnonlin

3

0.6114
2.0380
1.3948
0.3585
1.5498
fval =
37.3806
exitflag =
1
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Passing Extra Parameters

Sometimes objective or constraint functions have parameters in addition
to the independent variable. There are three methods of including these
parameters:

®* “Anonymous Functions” on page 2-17

¢ “Nested Functions” on page 2-19

® “Global Variables” on page 2-20

Global variables are troublesome because they do not allow names to be
reused among functions. It is better to use one of the other two methods.

For example, suppose you want to minimize the function

f(x) = (a —bx12 +xf/3)x12 +X1X9 + (—c+ cx%)x%, (2-1)

for different values of a, b, and c. Solvers accept objective functions that
depend only on a single variable (x in this case). The following sections show
how to provide the additional parameters a, b, and c. The solutions are for
parameter values a = 4, b = 2.1, and ¢ = 4 near x, = [0.5 0.5] using fminunc.

Anonymous Functions
To pass parameters using anonymous functions:

1 Write an M-file containing the following code:

function y = parameterfun(x,a,b,c)
y = (a - b*x(1)"2 + x(1)"4/3)*x(1)"2 + x(1)*x(2) + ...
(-c + c*x(2)"2)*x(2)"2;

2 Assign values to the parameters and define a function handle f to an
anonymous function by entering the following commands at the MATLAB
prompt:

a=4; b=2.1; c = 4; % Assign parameter values
x0 = [0.5,0.5];

2-17
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f = @(x)parameterfun(x,a,b,c)
3 Call the solver fminunc with the anonymous function:
[x,fval] = fminunc(f,x0)
The following output is displayed in the command window:

Warning: Gradient must be provided for trust-region method;
using line-search method instead.

> In fminunc at 265
Optimization terminated: relative infinity-norm of gradient less than options.TolFun.
X =

-0.0898 0.7127
fval =

-1.0316

Note The parameters passed in the anonymous function are those that exist
at the time the anonymous function is created. Consider the example

a:

4; b = 2.1; c = 4;
f = @(x)

H

(x)parameterfun(x,a,b,c)

Suppose you subsequently change, a to 3 and run
[x,fval] = fminunc(f,x0)

You get the same answer as before, since parameterfun uses a = 4, the value
when parameterfun was created.

To change the parameters that are passed to the function, renew the
anonymous function by reentering it:

a = 3;
f @(x)parameterfun(x,a,b,c)

You can create anonymous functions of more than one argument. For
example, to use 1sqcurvefit, first create a function that takes two input
arguments, x and xdata:
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fh = @(x,xdata) (sin(x).*xdata +(x."2).*cos(xdata));
x = pi; xdata = pi*[4;2;3];
fh(x, xdata)

ans

9.8696
9.8696
-9.8696

Now call 1sqcurvefit:

% Assume ydata exists
x = lsqcurvefit(fh,x,xdata,ydata)

Nested Functions

To pass the parameters for Equation 2-1 via a nested function, write a single
M-file that

e Accepts a, b, ¢, and x0 as inputs

¢ Contains the objective function as a nested function

e (Calls fminunc

Here is the code for the M-file for this example:

function [x,fval] = runnested(a,b,c,x0)
[x,fval] = fminunc(@nestedfun,x0);
% Nested function that computes the objective function
function y = nestedfun(x)
y = (a - b*x(1)"2 + x(1)74/3)*x(1)"2 + x(1)*x(2) +...
(-c + c*x(2)"2)*x(2)"2;
end
end

Note that the objective function is computed in the nested function nestedfun,
which has access to the variables a, b, and c.

To run the optimization, enter:

a=4; b=2.1; ¢ = 4;% Assign parameter values
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x0 = [0.5,0.5];
[x,fval] = runnested(a,b,c,x0)

The output is the same as in “Anonymous Functions” on page 2-17.

Global Variables

Global variables can be troublesome, it is better to avoid using them. To use
global variables, declare the variables to be global in the workspace and in
the functions that use the variables.

1 Write an M-file containing code for your function:

function y = globalfun(x)

global a b ¢

y = (a - b*x(1)72 + x(1)"4/3)*x(1)"2 + x(1)*x(2) + ...
(-c + c*x(2)"2)*x(2)"2;

2 In your MATLAB workspace, define the variables and run fminunc:
global a b c;
a=4; b=2.1; ¢c = 4; % Assign parameter values
X0 = [0.5,0.5];
[x,fval] = fminunc(@globalfun,x0)

The output is the same as in “Anonymous Functions” on page 2-17.
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Choosing a Solver

In this section...

“Optimization Decision Table” on page 2-24

“Problems Handled by Optimization Toolbox Functions” on page 2-21

Problems Handled by Optimization Toolbox Functions

The following tables show the functions available for minimization, equation
solving, multiobjective optimization, and solving least-squares or data-fitting

problems.

Minimization Problems

Type Formulation Solver
Scalar minimization fminbnd
min f(x)
X
such that [ < x < u (x is scalar)
Unconstrained minimization fminunc,
min f(x) fminsearch
x
Linear programming linprog
min f Ty
x
such that Ax<b, Aeqx=beq, I<x<u
Quadratic programming quadprog
mxinleHx +clx
such that Ax<b, Aeqx=beq, [<x<u

2-21
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Minimization Problems (Continued)

Type Formulation Solver
Constrained minimization fmincon
min f(x)
X
such that c¢(x) <0, ceq(x) =0, Ax<b,
Aegx=beq, [<x<u
Semi-infinite minimization fseminf
min f(x)
X
such that K(x,w) <0 for all w, c(x) <0,
ceq(x) =0, Ax<b, Aeqx=beq, [<x<u
Binary integer programming bintprog
min f Ty
X
such that A«x<b, Aeqx=beq, xbinary
Multiobjective Problems
Type Formulation Solver
Goal attainment fgoalattain
miny
x,Y
such that F(x) —w-y<goal, c(x)<0, ceq(x)=0,
Ax<b, Aegqx=beq, I<x<u
Minimax fminimax

min max F;(x)
X 12
such that c¢(x) <0, ceq(x) =0, Ax<b,
Aeqx=beq, [<x<u
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Equation Solving Problems

Type Formulation Solver

Linear equations Cx =d, n equations, n variables \ (matrix left division)
Nonlinear equation of one flx)y=0 fzero

variable

Nonlinear equations F(x) = 0, n equations, n variables fsolve

Least-Squares (Model-Fitting) Problems

Type Formulation Solver
Linear least-squares \ (matrix left
. divisi
m1n||C-x—d||§ ivision)
X
m equations, n variables
Nonnegative lsgnonneg
linear-least-squares .
q min|C-x - d||§
X
such that x > 0
Constrained 1sglin
linear-least-squares .
tnear qu min|C-x - d||§
X
such that Ax < b, Aeqx = beq,
Ib<x<ub
Nonlinear least-squares lsgnonlin
min||F(x)||§ =min 2 F}z(x)
X X 5
14
such that b <x<ub
Nonlinear curve fitting l1sqcurvefit
min||F(x, xdata) - ydata”g
X
such that [b<x<ub
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Optimization Decision Table

The following table is designed to help you choose a solver. It does not address
multiobjective optimization or equation solving. There are more details on
all the solvers in “Problems Handled by Optimization Toolbox Functions”

on page 2-21.

Use the table as follows:

1 Identify your objective function as one of five types:
® Linear
® Quadratic
® Sum-of-squares (Least squares)
® Smooth nonlinear

¢ Nonsmooth

2 Identify your constraints as one of five types:
® None (unconstrained)
¢ Bound
¢ Linear (including bound)
¢ General smooth
® Discrete (integer)
3 Use the table to identify a relevant solver.
In this table:
¢ Blank entries means there is no Optimization Toolbox solver specifically

designed for this type of problem.

® * means relevant solvers are found in Genetic Algorithm and Direct Search
Toolbox functions (licensed separately from Optimization Toolbox solvers).

e fmincon applies to most smooth objective functions with smooth
constraints. It is not listed as a preferred solver for least squares or linear
or quadratic programming because the listed solvers are usually more
efficient.
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® The table has suggested functions, but it is not meant to unduly restrict
your choices. For example, fmincon is known to be effective on some

non-smooth problems.

® The Genetic Algorithm and Direct Search Toolbox function ga can be
programmed to address discrete problems. It is not listed in the table
because additional programming is needed to solve discrete problems.

Solvers by Objective and Constraint

Constraint Objective Type
T A q
ype Linear Quadratic Least Smooth Nonsmooth
Squares nonlinear
None n/a (f = const, | quadprog, \, fminsearch, | fminsearch, *
or min = — ) | Theory, lsqcurvefit, | fminunc,
Examples l1sgnonlin, Theory,
Theory, Examples
Examples
Bound linprog, quadprog, lsqcurvefit, | fminbnd, &
Theory, Theory, 1sqlin, fmincon,
Examples Examples lsgnonlin, fseminf,
1sgnonneg, Theory,
Theory, Examples
Examples
Linear linprog, quadprog, 1sqlin, fmincon, *
Theory, Theory, Theory, fseminf,
Examples Examples Examples Theory,
Examples
General fmincon, fmincon, fmincon, fmincon, &
smooth Theory, Theory, Theory, fseminf,
Examples Examples Examples Theory,
Examples
Discrete bintprog,
Theory,
Example
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Note This table does not list multiobjective solvers nor equation solvers. See
“Problems Handled by Optimization Toolbox Functions” on page 2-21 for a
complete list of problems addressed by Optimization Toolbox functions.
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Solver Inputs and Outputs

In this section...

“Iterations and Function Counts” on page 2-27
“First-Order Optimality Measure” on page 2-28
“Tolerances and Stopping Criteria” on page 2-31
“Lagrange Multiplier Structures” on page 2-32
“Output Structures” on page 2-33

“Output Functions” on page 2-33

Iterations and Function Counts

In general, Optimization Toolbox solvers iterate to find an optimum. This
means a solver begins at an initial value x,, performs some intermediate
calculations that eventually lead to a new point x,, and then repeats the
process to find successive approximations x,, X, ... of the local minimum.
Processing stops after some number of iterations k.

At any step, intermediate calculations may involve evaluating the objective
function and constraints, if any, at points near the current iterate x,. For
example, the solver may estimate a gradient by finite differences. At each of
these nearby points, the function count (F-count) is increased by one.

e [f there are no constraints, the F-count reports the total number of
objective function evaluations.

o [f there are constraints, the F-count reports only the number of points
where function evaluations took place, not the total number of evaluations
of constraint functions.

¢ If there are many constraints, the F-count can be significantly less than
the total number of function evaluations.

F-count is a header in the iterative display for many solvers. For an example,
see “Interpreting the Result” on page 1-12.
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The F-count appears in the output structure as output.funcCount. This
enables you to access the evaluation count programmatically. For more
information on output structures, see “Output Structures” on page 2-33.

Note Intermediate calculations do not count towards the reported number of
iterations k. The number of iterations is the total number of steps x,, 1 <i < k.

First-Order Optimality Measure

First-order optimality is a measure of how close a point x is to optimal. It
1s used in all smooth solvers, constrained and unconstrained, though it
has different meanings depending on the problem and solver. For more
information about first-order optimality, see [1].

The tolerance TolFun relates to the first-order optimality measure. If the
optimality measure is less than TolFun, the solver iterations will end.

Unconstrained Optimality
For a smooth unconstrained problem,

min f(x),

the optimality measure is the infinity-norm (i.e., maximum absolute value)
of Vf(x):

First-order optimality measure = mfdx|(Vf (x))i| =|VF (). -
l

This measure of optimality is based on the familiar condition for a smooth
function to achieve a minimum: its gradient must be zero. For unconstrained
problems, when the first-order optimality measure is nearly zero, the objective
function has gradient nearly zero, so the objective function could be nearly
minimized. If the first-order optimality measure is not small, the objective
function is not minimized.
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Constrained Optimality—Theory

The theory behind the definition of first-order optimality measure for
constrained problems. The definition as used in Optimization Toolbox
functions is in “Constrained Optimality in Solver Form” on page 2-30.

For a smooth constrained problem let g and A be vector functions representing
all inequality and equality constraints respectively (i.e., bound, linear, and
nonlinear constraints):

min f(x) subject to g(x) <0, h(x)=0.
X

The meaning of first-order optimality in this case is more involved than for
unconstrained problems. The definition is based on the Karush-Kuhn-Tucker
(KKT) conditions. The KKT conditions are analogous to the condition that
the gradient must be zero at a minimum, modified to take constraints into
account. The difference is that the KKT conditions hold for constrained
problems.

The KKT conditions are given via an auxiliary Lagrangian function
L(x, l) = f(x) + 2 lg’igi(x) + 2 /lh,ihi (.’)C) (2_2)

The vector A, which is the concatenation of A, and 4,, is called the Lagrange

multiplier vector. Its length is the total number of constraints.

The KKT conditions are:

V,L(x,1) =0, (2-3)
g i8i(x) =0 Vi, (2-4)
g(x) <0,
h(x) =0,
)'g,i >0. (2-5)

The three expressions in Equation 2-5 are not used in the calculation of
optimality measure.
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The optimality measure associated with Equation 2-3 is
[V L, A = [VF )+ Ag Vigi () + Y A iV, 5 ()] (2-6)

The optimality measure associated with Equation 2-4 is
Az, (2-7)

where the infinity norm (maximum) is used for the vector A4;g;(x) .

The combined optimality measure is the maximum of the values calculated in
Equation 2-6 and Equation 2-7. In solvers that accept nonlinear constraint
functions, constraint violations g(x) > 0 or |A(x)| > 0 are measured and
reported as tolerance violations; see “Tolerances and Stopping Criteria” on
page 2-31.

Constrained Optimality in Solver Form

The first-order optimality measure used by toolbox solvers is expressed as
follows for constraints given separately by bounds, linear functions, and
nonlinear functions. The measure is the maximum of the following two norms,
which correspond to Equation 2-6 and Equation 2-7:

"VxL(x, l" = “Vf(x) + AT)"ineqlin + AeqT)’eqlin

+2 2"ineqnonlin,ivci (x) + Z )'eqnonlin,iVCQQi (x)

, (2-8)

|||li X | ilower,i ’|xi U | A‘upper,i ’|(Ax - b)i | )"ineqlin,i ’|ci (x)| )“ineqnonlin,i " ’ (2-9)

where the infinity norm (maximum) is used for the vector in Equation 2-8 and
in Equation 2-9. The subscripts on the Lagrange multipliers correspond to
solver Lagrange multiplier structures; see “Lagrange Multiplier Structures”
on page 2-32. The summations in Equation 2-8 range over all constraints. If
a bound is £Inf, that term is not considered constrained, so is not part of

the summation.
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For some large-scale problems with only linear equalities, the first-order
optimality measure is the infinity norm of the projected gradient (i.e., the
gradient projected onto the nullspace of Aeq).

Tolerances and Stopping Criteria

The number of iterations in an optimization depends on a solver’s stopping
criteria. These criteria include:

¢ First-order optimality measure

® Tolerance TolX

® Tolerance TolFun

e Tolerance TolCon

® Bound on number of iterations taken MaxIter

¢ Bound on number of function evaluations MaxFunEvals

First-order optimality measure is defined in “First-Order Optimality
Measure” on page 2-28. Iterations and function evaluations are discussed
in “Iterations and Function Counts” on page 2-27. The remainder of this
section describes how Optimization Toolbox solvers use stopping criteria to
terminate optimizations.

® TolXis a lower bound on the size of a step, meaning the norm of (x; — x,,,). If
the solver attempts to take a step that is smaller than TolX, the iterations
end. TolX is sometimes used as a relative bound, meaning iterations end
when | (x; —x;, )| <TolX*(1 + |x;|), or a similar relative measure.

® TolFun is a lower bound on the change in the value of the objective function
during a step. If |f(x;) — f(x,,,)| < TolFun, the iterations end. TolFun
1s sometimes used as a relative bound, meaning iterations end when
| flx) — f(x,,1) | <TolFun(l+ [f(x)I), or a similar relative measure.

® TolFun is also a bound on the first-order optimality measure. If the
optimality measure is less than TolFun, the iterations end. TolFun can also
be a relative bound.

® TolCon is an upper bound on the magnitude of any constraint functions.
If a solver returns a point x with c¢(x) > TolCon or |ceq(x)| > TolCon, the
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solver reports that the constraints are violated at x. TolCon can also be a
relative bound.

Note TolCon operates differently from other tolerances. If TolCon is not
satisfied (i.e., if the magnitude of the constraint function exceeds TolCon), the
solver attempts to continue, unless it is halted for another reason. A solver
does not halt simply because TolCon is satisfied.

There are two other tolerances that apply to particular solvers: TolPCG and
MaxPCGIter. These relate to preconditioned conjugate gradient steps. For
more information, see “Preconditioned Conjugate Gradient Method” on page
4-23.

There are several tolerances that apply only to the interior-point algorithm
in the solver fmincon. See “Optimization Options” on page 7-7 for more
information.

Lagrange Multiplier Structures
Constrained optimization involves a set of Lagrange multipliers, as described

in “First-Order Optimality Measure” on page 2-28. Solvers return estimated
Lagrange multipliers in a structure. The structure is called lambda, since the
conventional symbol for Lagrange multipliers is the Greek letter lambda (1).
The structure separates the multipliers into the following types, called fields:
e lower, associated with lower bounds

® upper, associated with upper bounds

® eqglin, associated with linear equalities

® ineqlin, associated with linear inequalities

® eqgnonlin, associated with nonlinear equalities

® inegnonlin, associated with nonlinear inequalities

To access, for example, the nonlinear inequality field of a Lagrange multiplier

structure, enter lambda.ingnonlin. To access the third element of the
Lagrange multiplier associated with lower bounds, enter lambda.lower(3).
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The content of the Lagrange multiplier structure depends on the solver.
For example, linear programming has no nonlinearities, so it does not have
eqnonlin or inegnonlin fields. Each applicable solver’s function reference
pages contains a description of its Lagrange multiplier structure under the
heading “Outputs.”

Output Structures

An output structure contains information on a solver’s result. All solvers can
return an output structure. To obtain an output structure, invoke the solver
with the output structure in the calling syntax. For example, to get an output
structure from 1sgnonlin, use the syntax

[x,resnorm,residual,exitflag,output] = lsqnonlin(...)

You can also obtain an output structure by running a problem using the
Optimization Tool. All results exported from Optimization Tool contain an
output structure.

The contents of the output structure are listed in each solver’s reference
pages. For example, the output structure returned by 1sgnonlin contains
firstorderopt, iterations, funcCount, cgiterations, stepsize,
algorithm, and message. To access, for example, the message, enter
output.message.

Optimization Tool exports results in a structure. The results structure
contains the output structure. To access, for example, the number of
iterations, use the syntax optimresults.output.iterations.

You can also see the contents of an output structure by double-clicking the
output structure in the MATLAB Workspace pane.

Output Functions

Introduction

For some problems, you might want output from an optimization algorithm at
each iteration. For example, you might want to find the sequence of points
that the algorithm computes and plot those points. To do this, create an
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output function that the optimization function calls at each iteration. See
“Output Function” on page 7-17 for details and syntax.

Generally, the solvers that can employ an output function are the ones that
can take nonlinear functions as inputs. You can determine which solvers can
have an output function by looking in the Options section of function reference
pages, or by checking whether the Output function option is available in the
Optimization Tool GUI for a solver.

Example: Using Output Functions

¢ “What the Example Contains” on page 2-34

¢ “Writing the Output Function” on page 2-35

¢ “Writing the Example M-File” on page 2-36

¢ “Running the Example” on page 2-37

What the Example Contains. The following example continues the one
in “Example: Nonlinear Inequality Constraints” on page 4-44, which calls
the function fmincon at the command line to solve a nonlinear, constrained
optimization problem. The example in this section uses an M-file to call
fmincon. The M-file also contains all the functions needed for the example,
including:

® The objective function

e The constraint function

¢ An output function that records the history of points computed by the
algorithm for fmincon. At each iteration of the algorithm for fmincon,
the output function:

= Plots the current point computed by the algorithm.

= Stores the point and its corresponding objective function value in a
variable called history, and stores the current search direction in a
variable called searchdir. The search direction is a vector that points in
the direction from the current point to the next one.

The code for the M-file is here: “Writing the Example M-File” on page 2-36.
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Writing the Output Function. You specify the output function in the
options structure

options = optimset('OutputFcn',@outfun)

where outfun is the name of the output function. When you call an
optimization function with options as an input, the optimization function
calls outfun at each iteration of its algorithm.

In general, outfun can be any MATLAB function, but in this example, it is a
nested subfunction of the M-file described in “Writing the Example M-File” on
page 2-36. The following code defines the output function:

function stop = outfun(x,optimValues,state)
stop = false;

switch state

case 'init'
hold on

case 'iter'
% Concatenate current point and objective function
% value with history. x must be a row vector.
history.fval = [history.fval; optimValues.fval];
history.x = [history.x; Xx];
% Concatenate current search direction with
% searchdir.
searchdir = [searchdir;...

optimValues.searchdirection'];

plot(x(1),x(2),'0");
% Label points with iteration number.
text(x(1)+.15,x(2),num2str(optimvValues.iteration));

case 'done’
hold off

otherwise

end
end

See “Using Function Handles with Nested Functions” in the MATLAB

Programming Fundamentals documentation for more information about
nested functions.
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The arguments that the optimization function passes to outfun are:

® x — The point computed by the algorithm at the current iteration
® optimValues — Structure containing data from the current iteration
The example uses the following fields of optimValues:
= optimValues.iteration — Number of the current iteration
= optimValues.fval — Current objective function value
= optimValues.searchdirection — Current search direction
® state — The current state of the algorithm ('init', 'interrupt', 'iter'

or 'done')

For more information about these arguments, see “Output Function” on page
7-17.

Writing the Example M-File. To create the M-file for this example:

1 Open a new M-file in the MATLAB Editor.
2 Copy and paste the following code into the M-file:

function [history,searchdir] = runfmincon

% Set up shared variables with OUTFUN
history.x = [1];

history.fval = [];

searchdir = [];

% call optimization

X0 = [-1 1];

options = optimset('outputfcn',@outfun, 'display’','iter’',...
"Algorithm', 'active-set');

xsol = fmincon(@objfun,x0,[1,[1,[]1,[1,[1,[],@confun,options);

function stop = outfun(x,optimValues,state)
stop = false;

switch state
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case 'init'

hold on
case 'iter'
Concatenate current point and objective function
value with history. x must be a row vector.
history.fval = [history.fval; optimValues.fvall;
history.x = [history.x; x];
Concatenate current search direction with
searchdir.
searchdir = [searchdir;...

optimValues.searchdirection'];

plot(x(1),x(2),'0");

% Label points with iteration number and add title.

text(x(1)+.15,x(2),...
num2str(optimvValues.iteration));
title('Sequence of Points Computed by fmincon');
case 'done'’
hold off

otherwise

end

o°

o°

o°

o°

end

function f = objfun(x)
f = exp(x(1))*(4*x(1)"2 + 2*x(2)"2 + 4*x(1)*x(2) +...
2*x(2) + 1);
end

function [c, ceq] = confun(x)
% Nonlinear inequality constraints
c =[1.5 + x(1)*x(2) - x(1) - x(2);

-x(1)*x(2) - 10];

% Nonlinear equality constraints
ceq = [];

end

end

3 Save the file as runfmincon.m in a directory on the MATLAB path.

Running the Example. To run the example, enter:
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[history searchdir]

= runfmincon;

This displays the following iterative output in the Command Window.

Iter F-count

N o o s~ W N

8

3
6
9
12
16
19
22
25
28

£(x)
1.8394
1.85127
0.300167
0.529835
0.186965
0.0729085
0.0353323
0.0235566
0.0235504

Max
constraint
0.5
-0.09197
9.33
0.9209
-1.517
0.3313
-0.03303
0.003184
9.032e-008

Line search Directional

steplength

1

derivative

0.109
-0.117
0.12
-0.224
-0.121
-0.0542
-0.0271
-0.0146

Optimization terminated: first-order optimality measure less

than options.TolFun and maximum constraint violation is less

than options.TolCon.

Active inequalities (to within options.TolCon = 1e-006):

lower

upper

ineqlin

inegnonlin

First-order

optimality

0.778
0.313
0.232
0.13
0.054
0.0271
0.00587
8.51e-007

The output history is a structure that contains two fields:

history =

X:
fval:

[9x2 double]
[9x1 double]

Procedure
Infeasible

start point
Hessian modified

twice

The fval field contains the objective function values corresponding to the
sequence of points computed by fmincon:

history.fval

ans

1.8394
1.8513
0.3002
0.5298
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0.1870
0.0729
0.0353
0.0236
0.0236

These are the same values displayed in the iterative output in the column

with header f(x).

The x field of history contains the sequence of points computed by the

algorithm:

history.x
ans =

-1.0000
-1.3679
-5.5708
-4.8000
-6.7054
-8.0679
-9.0230
-9.5471
-9.5474

;o A DW= .

.0000
.2500
.4699
.2752
.2618
.0186
.0532
.0471
.0474

This example displays a plot of this sequence of points, in which each point

is labeled by its iteration number.
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Sequence of Points Computed by fmincon

35 02
3 |-
25F
03
2 |-
15
04 o1
1L O8Q6 g5 . . . . . . 50
-0 -9 -8 -7 -6 -5 -4 -3 -2 -1

The optimal point occurs at the eighth iteration. Note that the last two points
in the sequence are so close that they overlap.

The second output argument, searchdir, contains the search directions for
fmincon at each iteration. The search direction is a vector pointing from the
point computed at the current iteration to the point computed at the next
iteration:

searchdir =

-0.3679 0.2500
-4.2029 2.2199
0.7708 -1.1947
-3.8108 -2.0268
-1.3625 -0.2432
-0.9552 0.0346
-0.5241 -0.0061
-0.0003 0.0003
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Default Options Settings

In this section...

“Introduction” on page 2-41
“Changing the Default Settings” on page 2-41
“Large-Scale vs. Medium-Scale Algorithms” on page 2-45

Introduction

The options structure contains options used in the optimization routines.

If, on the first call to an optimization routine, the options structure is not
provided, or is empty, a set of default options is generated. Some of the
default options values are calculated using factors based on problem size, such
as MaxFunEvals. Some options are dependent on the specific optimization
routines and are documented on those function reference pages (See “Main
Algorithm” on page 4-74).

“Optimization Options” on page 7-7 provides an overview of all the options in
the options structure.

Changing the Default Settings

The function optimset creates or updates an options structure to pass

to the various optimization functions. The arguments to the optimset
function are option name and option value pairs, such as TolX and 1e-4. Any
unspecified properties have default values. You need to type only enough
leading characters to define the option name uniquely. Case is ignored for
option names. For option values that are strings, however, case and the exact
string are necessary.

help optimset provides information that defines the different options and
describes how to use them.

Here are some examples of the use of optimset.
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Returning All Options

optimset returns all the options that can be set with typical values and
default values.

Determining Options Used by a Function

The options structure defines the options that can be used by toolbox
functions. Because functions do not use all the options, it can be useful to find
which options are used by a particular function.

To determine which options structure fields are used by a function, pass the
name of the function (in this example, fmincon) to optimset:

optimset('fmincon')

or

optimset fmincon

or

optimset(@fmincon)

This statement returns a structure. Generally, fields not used by the function
have empty values ([ ]1); fields used by the function are set to their default
values for the given function. However, some solvers have different default
values depending on the algorithm used. For example, fmincon has a default
MaxIter value of 400 for the trust-region-reflective and active-set
algorithms, but a default value of 1000 for the interior-point algorithm.
optimset fmincon returns [] for the MaxIter field.

You can also check the available options and their defaults in the Optimization
Tool. These can change depending on problem and algorithm settings. These
three pictures show how the available options for derivatives change as the
type of supplied derivatives change:
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Problem Setup and Results

Dptions ==

Solver:

I fmincon - Constrained nonlinear minimization

Algorithm: I Trust region reflective

~Problem

Objective function: I @rosenboth

[
[
=l

Derivatives:

Start paint: Jlo.0]

Constraints:

Linear inequalities: A I b I
Linear equalities: Aeq: I beq: I

Bounds: Lower; I[-l 1]

Upper: |[2.3]

Nenlinear: constraint function: I

[=] User-supplied derivatives

B

[~ Validate user-supplied derivatives

Hessian sparsity pattern: % Use default: sparse{ones(numberCfyariables))

 Spedify: I

Hessian multiply Fupftion: (% Use default: Mo mulbiply Function

= Specify: I

Mipfmumn perturbation: % Use default: 12-8

= Specify: I

perturbation: (% Use default: 0.1

Algorithm: I Trust region reflective

~Praoblem

Objective Function: I @rosenboth

Derivatives: Gradient supplied

Start paint: f[o.01

Canstraints: /
Linear inegualities: iy I b: I /
Linear equalitizs: Aeq: I beq: I /
Bounds: Lower: I[—l.—l] Upper: |[2.3] /

Maonlinear constraint Function: |

/

Derivatives:

I Approximated by s-:l'-;r:-r/ LI

[~ validate user-supplied derivatives

fHessian sparsity pattern: ¥ Use default: sparse{ones{numberOfVariables))

= Specify: I

Hessian multiply Ffnction: % Use defauls: Mo mulbiply Funckion

= Specify; I

[=| Approxinfated derivatives

Derivatives: I Approximated by solver LI/  Specify: |
Settable
options
Problem Setup and Results Options B>
=] User-supplied derivatives -
Salver: I fmincan - Constrained nonlinear minimization LI I_I

Finite diffeye
Minimm perturbation: % Use default: 1e-8

(" Specify: |

Aimum perturbation: €% Use default: 0,1

(" Specify: I

Settable
options
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Problem Setup and Results

Dptions >

Salver:

I fmincan - Constrained nonlinear minimization

al

[=] User-supplied derivatives

Algorithm: I Trust region reflactive

[~ wvalidate user-supplied derivatives

Hessian sparsity pattern: (% Use default: sparse(ones(numberOfvariables))

~Praoblem

Objective function: I @rosenboth

= Specify: I

[
[
[

Derivatives:

Nonlinear. constraint Funckion:

Derivatives: Hessian multiply Fupétion: & Use default: No multiply Function
Start paint: = Specify: I
Constraints: / erivatives I
Linear inequalities: A: I b I / ke
mimupf perturbation;  f* Use default: 1e-8
Linear equalities: Aeq: I beq: I
Bounds: Lower: I[-l.-l] Upper: |[2.3] ) Specity: I

Maximum perturbation: % Use default: 0,1

= Specify: I

~N

I Approximated by s-jl'-;r:-r/ vJ’
/
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!/ 7
Settable //
options

Displaying Output

To display output at each iteration, enter
options = optimset('Display', 'iter');

This command sets the value of the Display option to 'iter', which causes

the solver to display output at each iteration. You can also turn off any output

display ('off'), display output only at termination ('final'), or display

output only if the problem fails to converge ('notify').

Choosing an Algorithm

Some solvers explicitly use an option called LargeScale for choosing which
algorithm to use: fminunc, 1linprog, and others. Other solvers do not use
the LargeScale attribute explicitly, but have an option called Algorithm
instead: fmincon, fsolve, and others. All algorithms in Algorithm solvers
are large scale, unless otherwise noted in their function reference pages. The
term large-scale is explained in “Large-Scale vs. Medium-Scale Algorithms”
on page 2-45. For all solvers that have a large-scale algorithm, the default
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1s for the function to use a large-scale algorithm (e.g., LargeScale is set to
‘on' by default).

To use a medium-scale algorithm in a solver that takes the LargeScale
option, enter

options = optimset('LargeScale', 'off');
For solvers that use the Algorithm option, choose the algorithm by entering
options = optimset('Algorithm', 'algorithm-name') ;

algorithm-name is the name of the chosen algorithm. You can find the
choices in the function reference pages for each solver.

Setting More Than One Option

You can specify multiple options with one call to optimset. For example, to
reset the output option and the tolerance on x, enter

options = optimset('Display','iter','TolX',1e-6);

Updating an options Structure

To update an existing options structure, call optimset and pass options
as the first argument:

options = optimset(options, 'Display',‘'iter','TolX',1e-6);

Retrieving Option Values

Use the optimget function to get option values from an options structure.
For example, to get the current display option, enter the following:

verbosity = optimget(options, 'Display');

Large-Scale vs. Medium-Scale Algorithms

An optimization algorithm is large scale when it uses linear algebra that
does not need to store, nor operate on, full matrices. This may be done
internally by storing sparse matrices, and by using sparse linear algebra
for computations whenever possible. Furthermore, the internal algorithms
either preserve sparsity, such as a sparse Cholesky decomposition, or do
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not generate matrices, such as a conjugate gradient method. Large-scale
algorithms are accessed by setting the LargeScale option to on, or setting the
Algorithm option appropriately (this is solver-dependent).

In contrast, medium-scale methods internally create full matrices and use
dense linear algebra. If a problem is sufficiently large, full matrices take up a
significant amount of memory, and the dense linear algebra may require a
long time to execute. Medium-scale algorithms are accessed by setting the
LargeScale option to of f, or setting the Algorithm option appropriately (this
1s solver-dependent).

Don’t let the name “large-scale” mislead you; you can use a large-scale
algorithm on a small problem. Furthermore, you do not need to specify any
sparse matrices to use a large-scale algorithm. Choose a medium-scale
algorithm to access extra functionality, such as additional constraint types,
or possibly for better performance.
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Displaying Iterative Output

In this section...

“Introduction” on page 2-47
“Most Common Output Headings” on page 2-47
“Function-Specific Output Headings” on page 2-48

Note An optimization function does not return all of the output headings,
described in the following tables, each time you call it. Which output headings
are returned depends on the algorithm the optimization function uses for

a particular problem.

Introduction

When you set 'Display' to 'iter' in options, the optimization functions
display iterative output in the Command Window. This output, which
provides information about the progress of the algorithm, is displayed in
columns with descriptive headings. For example, if you run medium-scale
fminunc with 'Display’' set to 'iter', the output headings are

First-order
Iteration Func-count f(x) Step-size optimality

Most Common Output Headings

The following table lists some common output headings of iterative output.

Output Heading Information Displayed

Iteration or Iter Iteration number; see “Iterations and Function
Counts” on page 2-27

Func-count or Number of function evaluations; see “Iterations
F-count and Function Counts” on page 2-27

X Current point for the algorithm

f(x) Current function value
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Output Heading Information Displayed
Step-size Step size in the current search direction
Norm of step Norm of the current step

Function-Specific Output Headings

The following sections describe output headings of iterative output whose
meaning 1s specific to the optimization function you are using.

* “bintprog” on page 2-48

* “fminsearch” on page 2-49

® “fzero and fminbnd” on page 2-50

* “fminunc” on page 2-50

* “fsolve” on page 2-51

® “fgpoalattain, fmincon, fminimax, and fseminf” on page 2-51

* “linprog” on page 2-52

® “Isqnonlin and lsqcurvefit” on page 2-53

bintprog

The following table describes the output headings specific to bintprog.
bintprog
Output
Heading Information Displayed
Explored Cumulative number of explored nodes
nodes
Obj of LP Objective function value of the linear programming (LP)
relaxation relaxation problem
Obj of best Objective function value of the best integer point found
integer point | so far. This is an upper bound for the final objective

function value.
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bintprog

Output

Heading Information Displayed

Unexplored Number of nodes that have been set up but not yet
nodes explored

Best lower Objective function value of LP relaxation problem that

bound on obj

gives the best current lower bound on the final objective
function value

Relative
gap between 1006 - a)
bounds 6] +1 ’
where
® ) is the objective function value of the best integer
point.
® (o is the best lower bound on the objective function
value.
fminsearch

The following table describes the output headings specific to fminsearch.

fminsearch

Output

Heading Information Displayed

min f(x) Minimum function value in the current simplex
Procedure Simplex procedure at the current iteration. Procedures

include initial, expand, reflect, shrink, contract
inside, and contract outside. See “fminsearch
Algorithm” on page 4-11 for explanations of these
procedures.
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fzero and fminbnd
The following table describes the output headings specific to fzero and

fminbnd.
fzero and
fminbnd
Output
Heading Information Displayed
Procedure Procedure at the current operation. Procedures for
fzero:
e initial (initial point)
e search (search for an interval containing a zero)
® bisection (bisection search)
® interpolation
Operations for fminbnd:
e initial
e golden (golden section search)
® parabolic (parabolic interpolation)
fminunc

The following table describes the output headings specific to fminunc.

fminunc
Output
Heading

Information Displayed

First-order
optimality

First-order optimality measure (see “First-Order
Optimality Measure” on page 2-28)

CG-iterations

Number of conjugate gradient iterations taken by the
current (optimization) iteration (see “Preconditioned
Conjugate Gradient Method” on page 4-23)
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fsolve

The following table describes the output headings specific to fsolve.

fsolve Output
Heading

Information Displayed

First-order
optimality

First-order optimality measure (see “First-Order
Optimality Measure” on page 2-28)

Trust-region

Current trust-region radius (change in the norm of the

radius trust-region radius)

Residual Residual (sum of squares) of the function
Directional Gradient of the function along the search direction
derivative

fgoalattain, fmincon, fminimax, and fseminf

The following table describes the output headings specific to fgoalattain,
fmincon, fminimax, and fseminf.

fgoalattain,
fmincon,
fminimax, fseminf
Output Heading

Information Displayed

Max constraint

Maximum violation among all constraints, both
internally constructed and user-provided

First-order
optimality

First-order optimality measure (see “First-Order
Optimality Measure” on page 2-28)

CG-iterations

Number of conjugate gradient iterations taken by the
current (optimization) iteration (see “Preconditioned
Conjugate Gradient Method” on page 4-23)

Trust-region
radius

Current trust-region radius

Residual

Residual (sum of squares) of the function

Attainment factor

Value of the attainment factor for fgoalattain
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fgoalattain,
fmincon,
fminimax, fseminf
Output Heading

Information Displayed

Objective value

Objective function value of the nonlinear
programming reformulation of the minimax problem
for fminimax

Directional Current gradient of the function along the search

derivative direction

Procedure Hessian update and QP subproblem. The Procedure
messages are discussed in “Updating the Hessian
Matrix” on page 4-29.

linprog
The following table describes the output headings specific to 1inprog.

linprog Output

Heading Information Displayed

Primal Infeas Primal infeasibility

A*x-b

Dual Infeas Dual infeasibility

A'*y+z-w-f

Duality Gap Duality gap (see “Large Scale Linear Programming” on

X'*z+s'*w page 4-74) between the primal objective and the dual

objective. s and w appear only in this equation if there
are finite upper bounds.

Total Rel Total relative error, described at the end of “Main

Error Algorithm” on page 4-74.

Objective f'*x | Current objective value
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Isqnonlin and Isqcurvefit
The following table describes the output headings specific to 1sqnonlin and

lsqcurvefit.

Isqnonlin and

Isqcurvefit

Output

Heading Information Displayed

Resnorm Value of the squared 2-norm of the residual at x
Residual Residual vector of the function

First-order
optimality

First-order optimality measure (see “First-Order
Optimality Measure” on page 2-28)

CG-iterations

Number of conjugate gradient iterations taken by the
current (optimization) iteration (see “Preconditioned
Conjugate Gradient Method” on page 4-23)

Directional Gradient of the function along the search direction
derivative
Lambda A, value defined in “Levenberg-Marquardt Method” on

page 4-121. (This value is displayed when you use the
Levenberg-Marquardt method and omitted when you
use the Gauss-Newton method.)
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Typical Problems and How to Deal with Them

Optimization problems can take many iterations to converge and can be
sensitive to numerical problems such as truncation and round-off error in the
calculation of finite-difference gradients. Most optimization problems benefit
from good starting guesses. This improves the execution efficiency and can
help locate the global minimum instead of a local minimum.

Advanced problems are best solved by an evolutionary approach, whereby a
problem with a smaller number of independent variables is solved first. You
can generally use solutions from lower order problems as starting points for
higher order problems by using an appropriate mapping.

The use of simpler cost functions and less stringent termination criteria in the
early stages of an optimization problem can also reduce computation time.
Such an approach often produces superior results by avoiding local minima.

Optimization Toolbox functions can be applied to a large variety of problems.
Used with a little “conventional wisdom,” you can overcome many of the
limitations associated with optimization techniques. Additionally, you

can handle problems that are not typically in the standard form by using
an appropriate transformation. Below is a list of typical problems and
recommendations for dealing with them.

Troubleshooting

Problem Recommendation

fminunc produces If you are not supplying analytically determined gradients and the

warning messages and termination criteria are stringent, fminunc often exhibits slow

seems to exhibit slow convergence near the solution due to truncation error in the gradient

convergence near the calculation. Relaxing the termination criteria produces faster,

solution. although less accurate, solutions. For the medium-scale algorithm,
another option is adjusting the finite-difference perturbation levels,
DiffMinChange and DiffMaxChange, which might increase the
accuracy of gradient calculations.
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Troubleshooting (Continued)

Problem

Recommendation

Sometimes an
optimization problem
has values of x for
which it is impossible to
evaluate the objective
function fun or the
nonlinear constraints
function nonlcon.

Place bounds on the independent variables or make a penalty
function to give a large positive value to f and g when infeasibility is
encountered. For gradient calculation, the penalty function should be
smooth and continuous.

The function that is
being minimized has
discontinuities.

The derivation of the underlying method is based upon functions
with continuous first and second derivatives. Some success might
be achieved for some classes of discontinuities when they do not
occur near solution points. One option is to smooth the function.
For example, the objective function might include a call to an
interpolation function to do the smoothing.

Or, for the medium-scale algorithms, you can adjust the
finite-difference parameters in order to jump over small
discontinuities. The variables DiffMinChange and DiffMaxChange
control the perturbation levels for x used in the calculation of
finite-difference gradients. The perturbation, Ax, is always in the
range DiffMinChange < Dx < DiffMaxChange.

Warning messages are
displayed.

This sometimes occurs when termination criteria are overly stringent,
or when the problem is particularly sensitive to changes in the
independent variables. This usually indicates truncation or round-off
errors in the finite-difference gradient calculation, or problems in
the polynomial interpolation routines. These warnings can usually
be ignored because the routines continue to make steps toward the
solution point; however, they are often an indication that convergence
will take longer than normal. Scaling can sometimes improve the
sensitivity of a problem.
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Troubleshooting (Continued)

Problem

Recommendation

The independent
variables, x, can only
take on discrete values,
for example, integers.

This type of problem commonly occurs when, for example, the
variables are the coefficients of a filter that are realized using
finite-precision arithmetic or when the independent variables
represent materials that are manufactured only in standard amounts.

Although Optimization Toolbox functions are not explicitly set up to
solve discrete problems, you can solve some discrete problems by first
solving an equivalent continuous problem. Do this by progressively
eliminating discrete variables from the independent variables, which
are free to vary.

Eliminate a discrete variable by rounding it up or down to the nearest
best discrete value. After eliminating a discrete variable, solve a
reduced order problem for the remaining free variables. Having
found the solution to the reduced order problem, eliminate another
discrete variable and repeat the cycle until all the discrete variables
have been eliminated.

dfildemo is a demonstration routine that shows how filters with
fixed-precision coefficients can be designed using this technique.
(From the MATLAB Help browser or the MathWorks™ Web site
documentation, you can click the demo name to display the demo.)

The minimization
routine appears to
enter an infinite loop
or returns a solution
that does not satisfy the
problem constraints.

Your objective (fun), constraint (nonlcon, seminfcon), or gradient
(computed by fun) functions might be returning Inf, NaN, or complex
values. The minimization routines expect only real numbers to be
returned. Any other values can cause unexpected results. Insert
some checking code into the user-supplied functions to verify that
only real numbers are returned (use the function isfinite).

You do not get the
convergence you expect
from the 1sgnonlin
routine.

You might be forming the sum of squares explicitly and returning
a scalar value. 1sqnonlin expects a vector (or matrix) of function
values that are squared and summed internally.
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Local vs. Global Optima

What Are Local and Global Optima?

Usually, the goal of an optimization is to find a local minimum of a
function—a point where the function value is smaller than at nearby points,
but possibly greater than at a distant point in the search space. Sometimes
the goal of an optimization is to find the global minimum—a point where the
function value is smaller than all others in the search space. In general,
optimization algorithms return a local minimum. This section describes why
solvers behave this way, and gives suggestions for ways to search for a global
minimum, if needed.

Basins of Attraction

If an objective function f(x) is smooth, the vector —Vf(x) points in the direction
where f(x) decreases most quickly. The equation of steepest descent, namely

d

7 x(t) = -VF(x(t)),

yields a path x(¢) that goes to a local minimum as ¢ gets large. Generally,
initial values x(0) that are near to each other give steepest descent paths that
tend to the same minimum point along their steepest descent paths. The

set of initial values that lead to the same local minimum is called a basin of
attraction for steepest descent.

The following figure shows two one-dimensional minima. Different basins of
attraction are plotted with different line styles, and directions of steepest
descent are indicated by arrows. For this and subsequent figures, black dots
represent local minima. Every steepest descent path, starting at a point x(0),
goes to the black dot in the basin containing x(0).
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f(x)
A

/

- — - —» - x
»

One-dimensional basins

The following figure shows how steepest descent paths can be more
complicated in more dimensions.

One basin of attraction, showing steepest descent paths from various
starting points

The following figure shows even more complicated paths and basins.
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Several basins of attraction

Constraints can break up one basin of attraction into several pieces, where a
steepest descent path may be restricted from proceeding.

Searching For Global Optima

Many numerical methods for optimization are based, in part, on the method
of steepest descent.

Note Solvers do not precisely follow steepest descent paths. They attempt to
take large steps, in the interest of efficiency. Basins of attraction associated
with solver algorithms can be more complex than those of steepest descent.

The problem of global optimization turns into two parts:

¢ Finding a good initial value for optimizers

¢ Finding the minimum point in the basin associated with the initial value
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Note Optimization Toolbox solvers generally find the minimum point in the
basin, but leave the choice of starting point to you.

Generally, Optimization Toolbox solvers are not designed to find global
optima. They find the optimum in the basin of attraction of the starting point.
If you need a global optimum, you must find an initial value contained in the
basin of attraction of a global optimum.

There are some exceptions to this general rule.

¢ Linear programming and positive definite quadratic programming
problems are convex, with convex feasible regions, so there is only one
basin of attraction. Indeed, under certain choices of options, linprog
ignores any user-supplied starting point, and quadprog does not require
one, though supplying one can sometimes speed a minimization.

e Multiobjective optimization does not have basins of attraction, but still
depends on initial values.

* Some Genetic Algorithm and Direct Search Toolbox functions, such as
simulannealbnd, are designed to search through more than one basin
of attraction.

Suggestions for ways to set initial values to search for a global optimum:

e Use a regular grid of initial points.

¢ Use random points drawn from a uniform distribution if your problem has
all its coordinates bounded, or from normal, exponential, or other random
distributions if some components are unbounded. The less you know about
the location of the global optimum, the more spread-out your random
distribution should be. For example, normal distributions rarely sample
more than three standard deviations away from their means, but a Cauchy
distribution (density 1/(mm(1 + x2))) makes hugely disparate samples.

e Use identical initial points with added random perturbations on each
coordinate, bounded, normal, exponential, or other.
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® Use the Genetic Algorithm and Direct Search Toolbox function
gacreationlinearfeasible to obtain a set of random initial points in a
region with linear constraints.

The more you know about possible initial points, the more focused and
successful your search will be.
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Getting Started with the Optimization Tool

In this section...

“Introduction” on page 3-2
“Opening the Optimization Tool” on page 3-2
“Steps for Using the Optimization Tool” on page 3-5

Introduction

The Optimization Tool is a GUI for solving optimization problems. With the
Optimization Tool, you select a solver from a list and set up your problem
visually. If you are familiar with the optimization problem you want to
solve, the Optimization Tool lets you select a solver, specify the optimization
options, and run your problem. You can also import and export data from the
MATLAB workspace, and generate M-files containing your configuration for
the solver and options.

Opening the Optimization Tool
To open the tool, type

optimtool

in the Command Window. This opens the Optimization Tool, as shown in
the following figure.
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File Help
Problem Setup and Results Dptions Quick Reference
[=] Stopping criteria I; .
Salver: I fmincan - Constrained nonlinear minimization LI fmincon Solver
; - - Max iterations: * Use default: 400 Find a minimum of a
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You can also open the Optimization Tool from the main MATLAB window
as pictured:

<€k Model-Based Calibration
q‘ﬁ Meural Nebwork

i OPC

B Optimization Tool (optimtool)
@ Help

Q Dermos

@ Produck Page (web)

- ',l Cipkimizakion

s:ﬁ. Partial Differential Equakion
ol RF

c@k Robust Control

<€L Signal Processing

<€k Spline

b Statistics

ﬁ@k Syrnbalic Math
<€k System Identification
&% Yirtual Reality

v v v v v v v v v vy BT ¥ ¥

L MATLAB b
=) Toolboxes

B simulink 3
B Glocksets b
Shortcuts J
3% Desktop Tools
& web b

% Preferences. .,

] Find Files. .
@ Help

@ Dernos

|-£~. start

The reference page for the Optimization Tool provides variations for starting
the optimtool function.
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Steps for Using the Optimization Tool

This is a summary of the steps to set up your optimization problem and view
results with the Optimization Tool.

7. Import and export
problems, options, ) )
and results 4. Specify options

) Ogtimization Tool

File Help
Problem Setup and Results Options
[=] Stopping criteria
1. Select solver—-saiver: I Fmincon - Constrained nanlinear minimization LI
Max iterations: ¥ Use default: 400
Algarithm: I Trust region reflective LI
b " Specify: I
. Problem
fZUnSC‘t)I%CT;'IIfy — 1 Objective function: I ﬂ Max Function evaluations: ¥ Use default: 100*numberOfVariables
to minimize Derivatives: I Approximated by solver j " Speciy: I
= Start poink: | X kolerance: ¥ Use default: 12-06
Constraints: ® Sy I
3 S t b| Linear inequalities: A: I b: Function tolerance: * Use defaulk: 12-08
. oet problem
p Linear equalities: Aeq: beq: " Specify:
parameters for
selected solver Bounds: Lower: I Upper: Nonlinear constraint tolerance: (+ Use default: 1e-6

Nonlinear constraint function: I " Specify: I o
Derivatives: I Approximated by solver e l
| Derivativ PR . SOP constraint bolerance; f¥ Use default; 1e-6

rRun solver and view result: ) Specify: I

5. Run Solver—t— Start | Pause | top | Unboundedness threshold: {% | Use default; -1e20

Current iteration: Clear Resulks  specfy: I

=] Function valug check |

™ Error if user-supplied Function returns Inf, NaN or complex

[=] User-supplied derivatives |

[T validate user-supplied derivatives

6. View solver Hessian sparsity pattern: {* Use default: sparse{ones(numberOfvariables))
status = specify: |
and results
Hessian multiply Function: % Use default: Mo mulkisly function
— ) specify: |
|1l Final paint: = Approximated derivatives |
& Finite differences:
Minimum perturbation:  (* Use defaulk: 12-8
i~ Specify: I
_‘I _;I Maximum perturbation: * Use defaulk: 0.1

]
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Running a Problem in the Optimization Tool

In this section...

“Introduction” on page 3-6

“Pausing and Stopping the Algorithm” on page 3-7
“Viewing Results” on page 3-7

“Final Point” on page 3-7

“Starting a New Problem” on page 3-8

“Closing the Optimization Tool” on page 3-9

Introduction

After defining your problem and specifying the options, you are ready to run
the solver.

~Run salver and view results

Skart | Pause | Stop |

Current ikeration: I Clear Results

%
—

Final point:
I L
To run the selected solver, click the Start button. For most solvers, as the

algorithm runs, the Current iteration field updates. This field does not
update for solvers for which the current iteration does not apply.
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Pausing and Stopping the Algorithm

While the algorithm is running, you can

¢ (Click Pause to temporarily suspend the algorithm. To resume the
algorithm using the current iteration at the time you paused, click Resume.

e (Click Stop to stop the algorithm. The Run solver and view results
window displays information for the current iteration at the moment you
clicked Stop.

You can export your results after stopping the algorithm. For details, see
“Exporting to the MATLAB Workspace” on page 3-14.

Viewing Results

When the algorithm terminates, the Run solver and view results window
displays the reason the algorithm terminated. To clear the Run solver and
view results window between runs, click Clear Results.

Displaying Plots

In addition to the Run solver and view results window, you can also
display measures of progress while the algorithm executes by generating
plots. Each plot selected draws a separate axis in the figure window. You
can select a predefined plot function from the Optimization Tool, or you can
write your own. For more information on what plot functions are available,
see “Plot Functions” on page 3-10.

Final Point

The Final point updates to show the coordinates of the final point
when the algorithm terminated. If you don’t see the final point, click the
upward-pointing triangle on the icon on the lower-left.
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Starting a New Problem

Resetting Options and Clearing the Problem

Selecting File > Reset Optimization Tool resets the problem definition and
options to the original default values. This action is equivalent to closing
and restarting the optimtool.

To clear only the problem definition, select File > Clear Problem Fields.
With this action, fields in the Problem Setup and Results pane are reset to
the defaults, with the exception of the selected solver and algorithm choice.
Any options that you have modified from the default values in the Options
pane are not reset with this action.

Setting Preferences for Changing Solvers

To modify how your options are handled in the Optimization Tool when you
change solvers, select File > Preferences, which opens the Preferences
dialog box shown below.

«): Preferences x|

@ When changing ko a different salver:

{+ Reset options ko defaulk values

[~ Prompt before resetting options to defaulk values

{ Keep current options if possible

Cancel |

The default value, Reset options to defaults, discards any options you
specified previously in the optimtool. Under this choice, you can select the
option Prompt before resetting options to defaults.

Alternatively, you can select Keep current options if possible to preserve
the values you have modified. Changed options that are not valid with the
newly selected solver are kept but not used, while active options relevant
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to the new solver selected are used. This choice allows you to try different
solvers with your problem without losing your options.

Closing the Optimization Tool
To close the optimtool window, select File > Close.
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In this section...

“Plot Functions” on page 3-10
“Output function” on page 3-11
“Display to Command Window” on page 3-11

Plot Functions

You can select a plot function to easily plot various measures of progress
while the algorithm executes. Each plot selected draws a separate axis in the
figure window. If available for the solver selected, the Stop button in the
Run solver and view results window to interrupt a running solver. You
can select a predefined plot function from the Optimization Tool, or you can
select Custom function to write your own. Plot functions not relevant to the
solver selected are grayed out. The following lists the available plot functions:

¢ Current point — Select to show a bar plot of the point at the current

iteration.

¢ Function count — Select to plot the number of function evaluations at

each iteration.

¢ Function value — Select to plot the function value at each iteration.

¢ Norm of residuals — Select to show a bar plot of the current norm of

residuals at the current iteration.

® Max constraint — Select to plot the maximum constraint violation value

at each 1teration.

¢ Current step — Select to plot the algorithm step size at each iteration.

¢ First order optimality — Select to plot the violation of the optimality

conditions for the solver at each iteration.

¢ Custom function — Enter your own plot function as a function handle. To

provide more than one plot function use a cell array, for example, by typing:

{@plotfcn,@plotfcn2}

See “Plot Functions” on page 7-26.



Specifying Certain Options

[=] Plak Functions

[T Current paint [T Function count [~ Funckion value

[T Max constraink [~ Current step [~ First arder optimality

[~ Custom Function: |

The graphic above shows the plot functions available for the default fmincon
solver.

Output function

Output function is a function or collection of functions the algorithm calls
at each iteration. Through an output function you can observe optimization
quantities such as function values, gradient values, and current iteration.
Specify no output function, a single output function using a function handle,
or multiple output functions. To provide more than one output function use
a cell array of function handles in the Custom function field, for example
by typing:

{@outputfcn,@outputfcn2}

For more information on writing an output function, see “Output Function”
on page 7-17.

| [=] Cukpuk Funckion |

[ Custam Funckion: I

Display to Command Window

Select Level of display to specify the amount of information displayed when
you run the algorithm. Choose from the following:

e off (default) — Display no output.
e final — Display only the reason for stopping at the end of the run.

® notify — Display output only if the function does not converge.
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e iterative — Display information at each iteration of the algorithm.

Set Node interval, with the bintprog solver selected, to specify the interval
of explored nodes you want to display output for. Note that integer feasible

solution nodes are always shown.

Selecting Show diagnostics lists problem information and options that have
changed from the defaults.

The graphic below shows the display options.

[ Display to command window I

Level of display: | off LI

[~ Show diagnostics
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Getting Help in the Optimization Tool

In this section...

“Quick Reference” on page 3-13
“Additional Help” on page 3-13

Quick Reference

The Optimization Tool provides extensive context-sensitive help directly in
the GUL

For assistance with the primary tasks in the Optimization Tool window, use
the Quick Reference pane. To toggle between displaying or hiding the

Quick Reference pane, do either of the following:

¢ Select Help > Show Quick Reference

® (Click the 7 or == buttons in the upper right of the GUI

To resize the Quick Reference pane, drag the vertical divider to the left or
to the right.

Additional Help

In addition to the Quick Reference pane, you can access the documentation
for the Optimization Tool by selecting Help > Optimization Tool Help.
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Importing and Exporting Your Work

In this section...
“Exporting to the MATLAB Workspace” on page 3-14

“Importing Your Work” on page 3-16
“Generating an M-File” on page 3-16

Exporting to the MATLAB Workspace

The Export to Workspace dialog box enables you to send your problem
information to the MATLAB workspace as a structure that you may then
manipulate in the Command Window.

To access the Export to Workspace dialog box shown below, select
File > Export to Workspace.

) Export To Workspace =0l x|
¥ Export problem and options to a MATLAB structure named: Fptimpmblem

[+ Include information needed to resume this run

[~ Export options to a MATLAB structure named: Fptinns
I- Export results to a MATLAB structure named: Fptimresurts|

OK Cancel |

You can specify a structure that contains:

¢ The problem and options information

¢ The problem and options information, and the state of the solver when
stopped (this means the latest point for most solvers, the current population
for Genetic Algorithms solvers, and the best point found for Simulated
Annealing and Threshold Acceptance solvers)
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® The states of random number generators rand and randn at the start of
the previous run, by checking the Use random states from previous
run box for applicable solvers

® The options information only

® The results of running your problem in optimtool

Exported results structures contain all optional information. For example, an
exported results structure for 1sqcurvefit contains the data x, resnorm,
residual, exitflag, output, lambda, and jacobian

After you have exported information from the Optimization Tool to the
MATLAB workspace, you can see your data in the MATLAB Workspace
browser or by typing the name of the structure at the Command Window.
To see the value of a field in a structure, double-click on the structure

in the Workspace window. Alternatively, see the values by entering
structurename.fieldname at the command line. For example, so see the
message in an output structure, enter output.message. If a structure
contains structures, you can double-click again in the workspace browser,
or enter structurei.structure2.fieldname at the command line. For
example, to see the level of iterative display contained in the options structure
of an exported problem structure, enter optimproblem.options.Display.

You can run a solver on an exported problem at the command line by typing

solver(problem)

For example, if you have exported a fmincon problem named optimproblem,
you can type

fmincon(optimproblem)
This runs fmincon on the problem with the saved options structure contained

in optimproblem. You can exercise more control over outputs by typing, for
example,

[x,fval,exitflag] = fmincon(optimproblem)

or use any other supported syntax.
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Importing Your Work

Whether you saved options from Optimization Toolbox functions at the
Command Window or if you exported options, or the problem and options, from
the optimtool, you can resume work on your problem using the optimtool.

There are three ways to import your options, or problem and options, to
optimtool.

e (Call the optimtool function from the Command Window specifying your
options, or problem and options, as the input, tor example,

optimtool(options)

e Select File > Import Options in the Optimization Tool.

¢ Select File > Import Problem in the Optimization Tool.

The methods described above require that the options, or problem and options,
be present in the MATLAB workspace.

If you import a problem that was generated with the Include information
needed to resume this run box checked, the initial point is the latest
point generated in the previous run. (For Genetic Algorithm solvers, the
initial population is the latest population generated in the previous run. For
Simulated Annealing and Threshold Acceptance solvers, the initial point is
the best point generated in the previous run.) If you import a problem that
was generated with this box unchecked, the initial point (or population) is the
initial point (or population) of the previous run.

Generating an M-File

You may want to generate an M-file to continue with your optimization
problem in the Command Window at another time. You can run the M-file
without modification to recreate the results that you created with the
Optimization Tool. You can also edit and modify the M-file and run it from
the Command Window.

To export data from the Optimization Tool to an M-file, select File > Generate
M-file.



Importing and Exporting Your Work

The M-file captures the following:

® The problem definition, including the solver, information on the function to
be minimized, algorithm specification, constraints, and start point

® The options (using optimset) with the currently selected option value
Running the M-file at the Command Window reproduces your problem results.
Although you cannot export your problem results to a generated M-file, you
can save them in a MAT-file that you can use with your generated M-file, by

exporting the results using the Export to Workspace dialog box, then saving
the data to a MAT-file from the Command Window.
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Optimization Tool Examples

In this section...

“About Optimization Tool Examples” on page 3-18

“Optimization Tool with the fmincon Solver” on page 3-18

“Optimization Tool with the Isqlin Solver” on page 3-22

About Optimization Tool Examples

This section contains two examples showing how to use the Optimization
Tool to solve representative problems. There are other examples available:
“Problem Formulation: Rosenbrock’s Function” on page 1-4 and “Example:
Constrained Minimization Using fmincon’s Interior-Point Algorithm With
Analytic Hessian” on page 4-50 in this User’s Guide, and several in the
Genetic Algorithm and Direct Search Toolbox User’s Guide.

Optimization Tool with the fmincon Solver

This example shows how to use the Optimization Tool with the fmincon
solver to minimize a quadratic subject to linear and nonlinear constraints
and bounds.

Consider the problem of finding [x,, x,] that solves

min f(x) = x12 + x22
X

subject to the constraints

0.5<x
—x1—%9+1<0
—x12—x22+130
—93612 —x22 +9<0
—x12—x2 <0

—x22+x1 <0
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The starting guess for this problem is x; = 3 and x, = 1.

Step 1: Write an M-file objfun.m for the objective function.

function f = objfun(x)
f = x(1)"2 + x(2)"2;

Step 2: Write an M-file nonlconstr.m for the constraints.

function [c,ceq] = nonlconstr(x)

c =[-x(1)"2 - x(2)*2 + 1;
-9*x(1)"2 - x(2)"2 + 9;
-x(1)72 + x(2);
-x(2)"2 + x(1)1;

ceq = [1;

Step 3: Set up and run the problem with the Optimization Tool.

1 Enter optimtool in the Command Window to open the Optimization Tool.

2 Select fmincon from the selection of solvers and change the Algorithm
field to Active set

Salver: I frincaon - Constrained nanlinear minimizatian - |

Algorithm: I Active st j

3 Enter @objfun in the Objective function field to call the M-file objfun.m.

4 Enter [3; 1] in the Start point field.

Objective funckion: I mobjfun

Derivatives: I Approximated by solver

[
[

Skart poink: |[3; 1]

5 Define the constraints.
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® To create variables for the equality constraints, enter [-1 -1] in the
A field and enter -1in the b field.

¢ Set the bounds on the variables to be 0.5 < x, by entering 0.5 for Lower.

e Enter @nonlconstr in the Nonlinear constraint function field to call
the M-file nonlconstr.m.

Conskrainks:

Linear inequalities: A I[-l -1] b: |-1
Linear equalities; Aeq: I beq: I
Bounds: Lower: IU.S Upper: I

Monlinear constraint funckion: I@nu:unlcu:unstr

Derivatives: I Approximated by salver ;I

6 In the Options pane, expand the Display to command window option
if necessary, and select Iterative to show algorithm information at the
Command Window for each iteration.

[=] Display ko command windaw

Level of display:

7 Click the Start button as shown in the following figure.

Run solver and view results

E'IEIF'IN Fause | Stop |

Current iteration: I Clear Results

8 When the algorithm terminates, under Run solver and view results the
following information is displayed:
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~Run solver and view resulks

Skart |

Pause | Stop |

Current ikeration: I? Clear Results

F %
=

Optimization running.

Optimization terminated.

Ohdective function wvalus: Z.000000000000001

Optimization terminated: first-order optimality measure less
than options.TolFun and maximum constraint violation is less
than options.TolCon.

Final poink:

Index <

Value

1

-
<

The Current iteration value when the algorithm terminated, which
for this example is 7.

The final value of the objective function when the algorithm terminated:

Objective function value: 2.000000000000001

The algorithm termination message:

Optimization terminated: first-order optimality measure less
than options.TolFun and maximum constraint violation is less
than options.TolCon.

The final point, which for this example is

1
1

9 In the Command Window, the algorithm information is displayed for each
iteration:
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max Line search Directional First-order

Iter F-count f(x) constraint steplength derivative optimality
0 3 10 2

1 6 4.84298 -0.1322 1 -3.4 1.74

2 9 4.0251 -0.01168 1 -0.78 4.08

3 12 2.42704 -0.03214 1 -1.37 1.09

4 15 2.03615 -0.004728 1 -0.373 0.995

5 18 2.00033 -5.596e-005 1 -0.0357 0.0664

6 21 2 -5.327e-009 1 -0.000326 0.000522

7 24 2 -2.22e-016 1 -2.69e-008 1.21e-008

Optimization terminated: first-order optimality measure less
than options.TolFun and maximum constraint violation is less
than options.TolCon.

Active inequalities (to within options.TolCon = 1e-006):

lower upper ineqglin inegnonlin
3
4
Reference

[1] Schittkowski, K., “More Test Examples for Nonlinear Programming
Codes,” Lecture Notes in Economics and Mathematical Systems, Number
282, Springer, p. 45, 1987.

Optimization Tool with the Isqlin Solver

This example shows how to use the Optimization Tool to solve a constrained
least-squares problem.

The Problem

The problem in this example is to find the point on the plane x;, + 2x, + 4x, =7
that is closest to the origin. The easiest way to solve this problem is to
minimize the square of the distance from a point x = (x;,x,,x;) on the plane to
the origin, which returns the same optimal point as minimizing the actual
distance. Since the square of the distance from an arbitrary point (x;,x,,x,) to

the origin is x12 + x% + x% , you can describe the problem as follows:
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min f(x) = x12 +x§ +x32,,
X

subject to the constraint
X, + 2x, + 4x, = 7.

The function f(x) is called the objective function and x, + 2x, + 4x, = 7 is an
equality constraint. More complicated problems might contain other equality
constraints, inequality constraints, and upper or lower bound constraints.

Setting Up the Problem
This section shows how to set up the problem with the 1sqlin solver in the
Optimization Tool.

1 Enter optimtool in the Command Window to open the Optimization Tool.

2 Select 1sqlin from the selection of solvers. Use the default large-scale
algorithm.

Saolver; I lsqlin - Constrained linear least squares - I

Alaarithrn: I Large scale ;I

3 Enter the following to create variables for the objective function:
¢ In the C field, enter eye(3).
¢ In the d field, enter zeros(3,1).

The C and d fields should appear as shown in the following figure.

Praoblem

(af IE";.-'EI:3:I d: Izeru:us{S,. 13

4 Enter the following to create variables for the equality constraints:
¢ In the Aeq field, enter [1 2 4].
¢ In the beq field, enter 7.
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The Aeq and beq fields should appear as shown in the following figure.

Constraints:

Linear inequalities: & I b: I
Linear equalities: fe: |[1 2 4] beq: I?
Bounds; Lowwer: I Lpper: I

5 Click the Start button as shown in the following figure.

Run solver and view results

E'IEIF'IN Fause | Stop |

Current iteration: I Clear Results

6 When the algorithm terminates, under Run solver and view results the
following information is displayed:
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~Run salver and view results

Skart | Pause | Shop

Current ikerakion: |1

Clzar Results

Optimization running.
Optimization terminated.

2.333333333333333
Optimization terminated.

F 5
=

Chijective function valus:

Final paink:

Index + |Walue

0,333
0.667
1,333

L Pd | =

for this example is 1.

The Current iteration value when the algorithm terminated, which

The final value of the objective function when the algorithm terminated:

Objective function value: 2.333333333333333

Optimization terminated.

0.3333
0.6667
1.3333

The algorithm termination message:

The final point, which for this example is
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e “Unconstrained Nonlinear Optimization” on page 4-3
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¢ “Constrained Nonlinear Optimization” on page 4-20
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¢ “Equation Solving Examples” on page 4-162
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Optimization Theory Overview

Optimization techniques are used to find a set of design parameters,

X = {%,,%;,...,X,}, that can in some way be defined as optimal. In a simple case
this might be the minimization or maximization of some system characteristic
that is dependent on x. In a more advanced formulation the objective function,
f(x), to be minimized or maximized, might be subject to constraints in the form
of equality constraints, G,(x) = 0 (i = 1,...,m,); inequality constraints, G,(x) <0
(z=m,+ 1,...,m); and/or parameter bounds, x,, x,.

A General Problem (GP) description is stated as

min f(x), (4-1)

subject to

G(x)=0 i=1,..,m,,
G0 i=m,+1,..,m,

where x is the vector of length n design parameters, f(x) is the objective
function, which returns a scalar value, and the vector function G(x) returns
a vector of length m containing the values of the equality and inequality
constraints evaluated at x.

An efficient and accurate solution to this problem depends not only on the size
of the problem in terms of the number of constraints and design variables but
also on characteristics of the objective function and constraints. When both
the objective function and the constraints are linear functions of the design
variable, the problem is known as a Linear Programming (LP) problem.
Quadratic Programming (QP) concerns the minimization or maximization of a
quadratic objective function that is linearly constrained. For both the LP and
QP problems, reliable solution procedures are readily available. More difficult
to solve is the Nonlinear Programming (NP) problem in which the objective
function and constraints can be nonlinear functions of the design variables.
A solution of the NP problem generally requires an iterative procedure

to establish a direction of search at each major iteration. This is usually
achieved by the solution of an LP, a QP, or an unconstrained subproblem.
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Unconstrained Nonlinear Optimization

In this section...

“Definition” on page 4-3
“Large Scale fminunc Algorithm” on page 4-3
“Medium Scale fminunc Algorithm” on page 4-6

“fminsearch Algorithm” on page 4-11

Definition
Unconstrained minimization is the problem of finding a vector x that is a local
minimum to a scalar function f(x):

min f(x)
X
The term unconstrained means that no restriction is placed on the range of x.

Large Scale fminunc Algorithm

Trust-Region Methods for Nonlinear Minimization

Many of the methods used in Optimization Toolbox solvers are based on trust
regions, a simple yet powerful concept in optimization.

To understand the trust-region approach to optimization, consider the
unconstrained minimization problem, minimize f(x), where the function takes
vector arguments and returns scalars. Suppose you are at a point x in n-space
and you want to improve, 1.e., move to a point with a lower function value.
The basic idea is to approximate f with a simpler function ¢, which reasonably
reflects the behavior of function fin a neighborhood N around the point x. This
neighborhood is the trust region. A trial step s is computed by minimizing (or
approximately minimizing) over N. This is the trust-region subproblem,
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min{q(s), se N}. (4-2)

The current point is updated to be x + s if f(x + s) < f(x); otherwise, the current
point remains unchanged and N, the region of trust, is shrunk and the trial
step computation is repeated.

The key questions in defining a specific trust-region approach to minimizing
f(x) are how to choose and compute the approximation ¢ (defined at the
current point x), how to choose and modify the trust region N, and how
accurately to solve the trust-region subproblem. This section focuses on the
unconstrained problem. Later sections discuss additional complications due
to the presence of constraints on the variables.

In the standard trust-region method ([48]), the quadratic approximation g
is defined by the first two terms of the Taylor approximation to F at x; the
neighborhood N is usually spherical or ellipsoidal in shape. Mathematically
the trust-region subproblem is typically stated

min {1 sTHs+sT g such that | Ds|| < A},
2 (4-3)

where g is the gradient of f at the current point x, H is the Hessian matrix
(the symmetric matrix of second derivatives), D is a diagonal scaling matrix, A
is a positive scalar, and || . || is the 2-norm. Good algorithms exist for solving
Equation 4-3 (see [48]); such algorithms typically involve the computation of a
full eigensystem and a Newton process applied to the secular equation

1 1

S - =0
Al

Such algorithms provide an accurate solution to Equation 4-3. However,
they require time proportional to several factorizations of H. Therefore, for
large-scale problems a different approach is needed. Several approximation
and heuristic strategies, based on Equation 4-3, have been proposed in

the literature ([42] and [50]). The approximation approach followed in
Optimization Toolbox solvers is to restrict the trust-region subproblem

to a two-dimensional subspace S ([39] and [42]). Once the subspace S

has been computed, the work to solve Equation 4-3 is trivial even if full
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eigenvalue/eigenvector information is needed (since in the subspace, the
problem is only two-dimensional). The dominant work has now shifted to
the determination of the subspace.

The two-dimensional subspace S is determined with the aid of a
preconditioned conjugate gradient process described below. The solver defines
S as the linear space spanned by s, and s,, where s, is in the direction of the
gradient g, and s, is either an approximate Newton direction, i.e., a solution to

H- Sg =—8, (4-4)
or a direction of negative curvature,
T
sy -H -s9 <0. (4-5)

The philosophy behind this choice of S is to force global convergence (via the
steepest descent direction or negative curvature direction) and achieve fast
local convergence (via the Newton step, when it exists).

A sketch of unconstrained minimization using trust-region ideas is now easy
to give:

1 Formulate the two-dimensional trust-region subproblem.
2 Solve Equation 4-3 to determine the trial step s.
3 If f(x + s) < f(x), thenx =x + s.

4 Adjust A.

These four steps are repeated until convergence. The trust-region dimension
A is adjusted according to standard rules. In particular, it is decreased if the
trial step is not accepted, i.e., f(x + s) > f(x). See [46] and [49] for a discussion
of this aspect.

Optimization Toolbox solvers treat a few important special cases of f with
specialized functions: nonlinear least-squares, quadratic functions, and linear
least-squares. However, the underlying algorithmic ideas are the same as for
the general case. These special cases are discussed in later sections.
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Preconditioned Conjugate Gradient Method

A popular way to solve large symmetric positive definite systems of linear
equations Hp = —g is the method of Preconditioned Conjugate Gradients
(PCG). This iterative approach requires the ability to calculate matrix-vector
products of the form H v where v is an arbitrary vector. The symmetric
positive definite matrix M is a preconditioner for H. That is, M = C?, where
C'HC'is a well-conditioned matrix or a matrix with clustered eigenvalues.

In a minimization context, you can assume that the Hessian matrix H is
symmetric. However, H is guaranteed to be positive definite only in the
neighborhood of a strong minimizer. Algorithm PCG exits when a direction of
negative (or zero) curvature is encountered, i.e., d’Hd < 0. The PCG output
direction, p, is either a direction of negative curvature or an approximate

(tol controls how approximate) solution to the Newton system Hp = —g. In
either case p is used to help define the two-dimensional subspace used in

the trust-region approach discussed in “Trust-Region Methods for Nonlinear
Minimization” on page 4-3.

Medium Scale fminunc Algorithm

Basics of Unconstrained Optimization

Although a wide spectrum of methods exists for unconstrained optimization,
methods can be broadly categorized in terms of the derivative information
that is, or is not, used. Search methods that use only function evaluations
(e.g., the simplex search of Nelder and Mead [30]) are most suitable for
problems that are not smooth or have a number of discontinuities. Gradient
methods are generally more efficient when the function to be minimized is
continuous in its first derivative. Higher order methods, such as Newton’s
method, are only really suitable when the second-order information is readily
and easily calculated, because calculation of second-order information, using
numerical differentiation, is computationally expensive.

Gradient methods use information about the slope of the function to dictate
a direction of search where the minimum is thought to lie. The simplest of
these is the method of steepest descent in which a search is performed in a
direction, —Vf(x), where Vf(x) is the gradient of the objective function. This
method is very inefficient when the function to be minimized has long narrow
valleys as, for example, is the case for Rosenbrock’s function
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2
£ =100(xy ~xF) +1-xp)2. (4-6)

The minimum of this function is at x = [1,1], where f(x) = 0. A contour map
of this function is shown in the figure below, along with the solution path to
the minimum for a steepest descent implementation starting at the point
[-1.9,2]. The optimization was terminated after 1000 iterations, still a
considerable distance from the minimum. The black areas are where the
method is continually zigzagging from one side of the valley to another. Note
that toward the center of the plot, a number of larger steps are taken when
a point lands exactly at the center of the valley.

Figure 4-1: Steepest Descent Method on Rosenbrock’s Function (Eq. 3-2)

This function, also known as the banana function, is notorious in
unconstrained examples because of the way the curvature bends around the
origin. Rosenbrock’s function is used throughout this section to illustrate the
use of a variety of optimization techniques. The contours have been plotted
in exponential increments because of the steepness of the slope surrounding
the U-shaped valley.
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Quasi-Newton Methods

Of the methods that use gradient information, the most favored are the
quasi-Newton methods. These methods build up curvature information at
each iteration to formulate a quadratic model problem of the form

1 7 T
min—x" Hx+c" x+b,
x 2 4-7)

where the Hessian matrix, H, is a positive definite symmetric matrix, c¢ is a
constant vector, and b is a constant. The optimal solution for this problem
occurs when the partial derivatives of x go to zero, i.e.,

Vf(x*)=Hx*+c=0. (4-8)
The optimal solution point, x*, can be written as

x*=—H e, (4-9)

Newton-type methods (as opposed to quasi-Newton methods) calculate H
directly and proceed in a direction of descent to locate the minimum after a
number of iterations. Calculating H numerically involves a large amount
of computation. Quasi-Newton methods avoid this by using the observed
behavior of f(x) and Vf(x) to build up curvature information to make an
approximation to H using an appropriate updating technique.

A large number of Hessian updating methods have been developed. However,
the formula of Broyden [3], Fletcher [12], Goldfarb [20], and Shanno [37]
(BFGS) is thought to be the most effective for use in a general purpose method.

The formula given by BFGS is

T T T
qr9r  Hi sp sty
Hk+l =Hk+ - ’

T T
qr s, Sk Hpsy (4-10)

where

Sk = Xpp41 — Xp»
qr, =V (xp41) = Vf ().
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As a starting point, H, can be set to any symmetric positive definite matrix,
for example, the identity matrix I. To avoid the inversion of the Hessian H,
you can derive an updating method that avoids the direct inversion of H by
using a formula that makes an approximation of the inverse Hessian H! at
each update. A well-known procedure is the DFP formula of Davidon [7],
Fletcher, and Powell [14]. This uses the same formula as the BFGS method
(Equation 4-10) except that g, is substituted for s,.

The gradient information is either supplied through analytically calculated
gradients, or derived by partial derivatives using a numerical differentiation
method via finite differences. This involves perturbing each of the design
variables, x, in turn and calculating the rate of change in the objective
function.

At each major iteration, k, a line search is performed in the direction

d=-Hp' - Vf(x). (4-11)

The quasi-Newton method is illustrated by the solution path on Rosenbrock’s
function in Figure 4-2, BFGS Method on Rosenbrock’s Function. The method
is able to follow the shape of the valley and converges to the minimum after
140 function evaluations using only finite difference gradients.

-15 -1 0.5 0 03 1 13 2

|
(5]

Figure 4-2: BFGS Method on Rosenbrock’s Function
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Line Search

Line search is a search method that is used as part of a larger optimization
algorithm. At each step of the main algorithm, the line-search method
searches along the line containing the current point, x,, parallel to the search
direction, which is a vector determined by the main algorithm. That is, the
method finds the next iterate x,,, of the form

Xpp1 = Xp T Fdy, (4-12)

where x, denotes the current iterate, d, is the search direction, and a* is a
scalar step length parameter.

The line search method attempts to decrease the objective function along the
line x, + a*d,, by repeatedly minimizing polynomial interpolation models of
the objective function. The line search procedure has two main steps:

¢ The bracketing phase determines the range of points on the line

Xp41 = %3 +a *dp, to be searched. The bracket corresponds to an interval
specifying the range of values of a.

® The sectioning step divides the bracket into subintervals, on which
the minimum of the objective function is approximated by polynomial
interpolation.

The resulting step length a satisfies the Wolfe conditions:
f(x +ady) < f(xp) +craVii dy, (4-13)

T T
Vf (x +ady)” dy, 2 oV, dy, (4-14)
where c; and ¢, are constants with 0 < ¢, <¢, < 1.

The first condition (Equation 4-13) requires that q,, sufficiently decreases the
objective function. The second condition (Equation 4-14) ensures that the step
length is not too small. Points that satisfy both conditions (Equation 4-13 and
Equation 4-14) are called acceptable points.

The line search method is an implementation of the algorithm described in
Section 2-6 of [13]. See also [31] for more information about line search.
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Hessian Update

Many of the optimization functions determine the direction of search by
updating the Hessian matrix at each iteration, using the BFGS method
(Equation 4-10). The function fminunc also provides an option to use the
DFP method given in “Quasi-Newton Methods” on page 4-8 (set HessUpdate
to 'dfp' in options to select the DFP method). The Hessian, H, is always
maintained to be positive definite so that the direction of search, d, is always
in a descent direction. This means that for some arbitrarily small step a in
the direction d, the objective function decreases in magnitude. You achieve
positive definiteness of H by ensuring that H is initialized to be positive

definite and thereafter q;z sp (from Equation 4-15) is always positive. The

term q;rf s;, 1s a product of the line search step length parameter a, and
a combination of the search direction d with past and present gradient
evaluations,

Tk sk = (Vf(xk+1 )\ d=VF(x)" d)~ (4-15)

You always achieve the condition that qgsk is positive by performing a
sufficiently accurate line search. This is because the search direction, d, is a
descent direction, so that a, and the negative gradient —Vf(x,)’d are always
positive. Thus, the possible negative term —Vf(x,,,)’d can be made as small in
magnitude as required by increasing the accuracy of the line search.

fminsearch Algorithm

fminsearch uses the Nelder-Mead simplex algorithm as described in [57].
This algorithm uses a simplex of n + 1 points for n-dimensional vectors x.
The algorithm first makes a simplex around the initial guess x, by adding

5% of each component x,(i) to x,, and using these n vectors as elements of
the simplex in addition to x,. (It uses 0.00025 as component i if x,(i) = 0.)
Then the algorithm modifies the simplex repeatedly according to the following
procedure.

Note The bold steps in the algorithm represent statements in the
fminsearch iterative display.

4-11
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1 Let x(i) denote the list of points in the current simplex, : = 1,...,n+1.

2 Order the points in the simplex from lowest function value f(x(1)) to
highest f(x(n+1)). At each step in the iteration, the current worst point
x(n+1) is discarded, and another point is accepted into the simplex (or, in
the case of step 7 below, all n points with values above f(x(1)) are changed).

3 Generate the reflected point
r=2m - x(nt+l),
where
m = Xx()/n, i = 1...n,
and calculate f(r).
4 If f(x(1)) < f(r) < f(x(n)), accept r and terminate this iteration. Reflect
5 If f(r) < f(x(1)), calculate the expansion point s
s=m + 2(m — x(n+1)),

and calculate f(s).
a If f(s) < f(r), accept s and terminate the iteration. Expand

b Otherwise, accept r and terminate the iteration. Reflect

6 If f(r) > f(x(n)), perform a contraction between m and the better of x(n+1)
and r:

a If f(r) < f(x(n+1)) (.e., r is better than x(n+1)), calculate
c=m+ (r—m)/2

and calculate f(c). If f(c) < f(r), accept ¢ and terminate the iteration.
Contract outside Otherwise, continue with Step 7 (Shrink).

b If f(r) > f(x(n+1)), calculate

cc=m + (x(n+1) — m)/2

4-12



Unconstrained Nonlinear Optimization

and calculate f(cc). If f(cc) < f(x(n+1)), accept cc and terminate the
iteration. Contract inside Otherwise, continue with Step 7 (Shrink).

7 Calculate the n points
v(@) = x2(1) + (x(@) — x(1))/2

and calculate f(v(Q)), i = 2,...,n+1. The simplex at the next iteration is x(1),
v(2),...,u(n+1). Shrink

Here is a picture of the points that may be calculated in the procedure, along
with each possible new simplex. The original simplex has a bold outline.

x(n+1)

The iterations proceed until a stopping criterion is met.

4-13
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Unconstrained Nonlinear Optimization Examples

In this section...

“Example: fminunc Unconstrained Minimization” on page 4-14

“Example: Nonlinear Minimization with Gradient and Hessian” on page
4-16

“Example: Nonlinear Minimization with Gradient and Hessian Sparsity
Pattern” on page 4-17

Example: fminunc Unconstrained Minimization

Consider the problem of finding a set of values [x,, x,] that solves

. _ o5 2 2
m;nf(x) e (4.961 +2x5 +4x1%9 + 2x9 + 1) (4-16)

To solve this two-dimensional problem, write an M-file that returns the
function value. Then, invoke the unconstrained minimization routine
fminunc.
Step 1: Write an M-file objfun.m.
function f = objfun(x)
f = exp(x(1))*(4*x(1)"2+2*x(2)"2+4*x (1) *x(2)+2*x(2)+1);
Step 2: Invoke one of the unconstrained optimization routines.
x0 = [-1,1]; % Starting guess

options = optimset('LargeScale', 'off');
[x,fval,exitflag,output] = fminunc(@objfun,x0,options)

This produces the following output:

Optimization terminated: relative infinity-norm
of gradient less than options.TolFun.
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0.5000 -1.0000

fval =
3.6609e-015

exitflag =
1

output =
iterations: 8
funcCount: 66
stepsize: 1
firstorderopt: 1.2284e-007
algorithm: 'medium-scale: Quasi-Newton line search'
message: 'Optimization terminated: relative infinity-norm
of gradient less than options.TolFun.'

The exitflag tells whether the algorithm converged. exitflag = 1 means
a local minimum was found. The meanings of flags are given in function
reference pages.

The output structure gives more details about the optimization. For fminunc,
it includes the number of iterations in iterations, the number of function
evaluations in funcCount, the final step-size in stepsize, a measure of
first-order optimality (which in this unconstrained case is the infinity norm of
the gradient at the solution) in firstorderopt, the type of algorithm used in
algorithm, and the exit message (the reason the algorithm stopped).

Pass the variable options to fminunc to change characteristics of the
optimization algorithm, as in

x = fminunc(@objfun,x0,options);

options is a structure that contains values for termination tolerances and
algorithm choices. Create an options structure using the optimset function:

options = optimset('LargeScale','off');

You can also create an options structure by exporting from the Optimization
Tool.

4-15
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In this example, we have turned off the default selection of the large-scale
algorithm and so the medium-scale algorithm is used. Other options include
controlling the amount of command line display during the optimization
iteration, the tolerances for the termination criteria, whether a user-supplied
gradient or Jacobian is to be used, and the maximum number of iterations or
function evaluations. See optimset, the individual optimization functions,
and “Optimization Options” on page 7-7 for more options and information.

Example: Nonlinear Minimization with Gradient and
Hessian

This example involves solving a nonlinear minimization problem with a
tridiagonal Hessian matrix H(x) first computed explicitly, and then by
providing the Hessian’s sparsity structure for the finite-differencing routine.

The problem is to find x to minimize

n-1

f@=3 [(x? s ) )

i=1 4-17)

where n = 1000.

Step 1: Write an M-file brownfgh.m that computes the
objective function, the gradient of the objective, and the sparse
tridiagonal Hessian matrix.

The file is lengthy so is not included here. View the code with the command

type brownfgh

Because brownfgh computes the gradient and Hessian values as well as the
objective function, you need to use optimset to indicate that this information
is available in brownfgh, using the GradObj and Hessian options.

Step 2: Call a nonlinear minimization routine with a starting
point xstart.

n = 1000;
xstart = -ones(n,1);
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xstart(2:2:n,1) = 1;
options = optimset('GradObj','on', 'Hessian','on');
[x,fval,exitflag,output] = fminunc(@brownfgh,xstart,options);

This 1000 variable problem is solved in about 7 iterations and 7 conjugate
gradient iterations with a positive exitflag indicating convergence. The final
function value and measure of optimality at the solution x are both close

to zero. For fminunc, the first order optimality is the infinity norm of the
gradient of the function, which is zero at a local minimum:

exitflag =
1
fval =
2.8709e-017
output =
iterations:
funcCount:
cgiterations:
firstorderopt: 4.7948e-010
algorithm: 'large-scale: trust-region Newton'
message: [1x137 char]

N © N

Example: Nonlinear Minimization with Gradient and
Hessian Sparsity Pattern

Next, solve the same problem but the Hessian matrix is now approximated by
sparse finite differences instead of explicit computation. To use the large-scale
method in fminunc, you must compute the gradient in fun; it is not optional
as in the medium-scale method.

The M-file function brownfg computes the objective function and gradient.
Step 1: Write an M-file brownfg.m that computes the objective
function and the gradient of the objective.

function [f,g] = brownfg(x)
% BROWNFG Nonlinear minimization test problem

o°

% Evaluate the function
n=length(x); y=zeros(n,1);

4-17
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i=1:(n-1);
y(i)=(x(1).%2).7(x(1i+1).%2+1) +
(x(i+1).72).7(x(1).%2+1);
f=sum(y);
% Evaluate the gradient if nargout > 1
if nargout > 1
i=1:(n-1); g = zeros(n,1);
g(i) = 2*(x(1i+1).%2+1).*x(1).* ...
((x(1).72).7(x(1i+1).72))+ ...
2*x (1) . *((x(1+1).72) .7 (x(1).%2+1)).*
log(x(i+1).%2);
g(i+tt1) = g(i+1) + ...
2*x (1+1) . *((x(1).72) .~ (x(1i+1)."2+1)).*
log(x(i)."2) +
2% (x(1).72+1).*x(1+1).*
((x(i+1).72)."(x(1).%2));
end

To allow efficient computation of the sparse finite-difference approximation of
the Hessian matrix H(x), the sparsity structure of H must be predetermined.
In this case assume this structure, Hstr, a sparse matrix, is available in file
brownhstr.mat. Using the spy command you can see that Hstr is indeed
sparse (only 2998 nonzeros). Use optimset to set the HessPattern option

to Hstr. When a problem as large as this has obvious sparsity structure,

not setting the HessPattern option requires a huge amount of unnecessary
memory and computation because fminunc attempts to use finite differencing
on a full Hessian matrix of one million nonzero entries.

You must also set the GradObj option to 'on' using optimset, since the
gradient is computed in brownfg.m. Then execute fminunc as shown in Step 2.

Step 2: Call a nonlinear minimization routine with a starting
point xstart.

fun = @brownfg;

load brownhstr % Get Hstr, structure of the Hessian
spy (Hstr) % View the sparsity structure of Hstr
n = 1000;

xstart = -ones(n,1);

xstart(2:2:n,1) = 1;



Unconstrained Nonlinear Optimization Examples

options = optimset('GradObj','on', 'HessPattern', Hstr);
[x,fval,exitflag,output] = fminunc(fun,xstart,options);

This 1000-variable problem is solved in eight iterations and seven conjugate
gradient iterations with a positive exitflag indicating convergence. The final
function value and measure of optimality at the solution x are both close

to zero (for fminunc, the first-order optimality is the infinity norm of the
gradient of the function, which is zero at a local minimum):

exitflag =
1
fval =
7.4739e-017
output =

iterations:
funcCount:
cgiterations:
firstorderopt:
algorithm:
message:

7
8
7
7.9822e-010

‘large-scale: trust-region Newton'
[1x137 char]
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Constrained Nonlinear Optimization

In this section...

“Definition” on page 4-20

“fmincon Trust Region Reflective Algorithm” on page 4-20
“fmincon Active Set Algorithm” on page 4-26

“fmincon Interior Point Algorithm” on page 4-35

“fminbnd Algorithm” on page 4-39

“fseminf Problem Formulation and Algorithm” on page 4-39

Definition
Constrained minimization is the problem of finding a vector x that is a local
minimum to a scalar function f(x) subject to constraints on the allowable x:

min f(x)

such that one or more of the following holds: c¢(x) <0, ceq(x) =0, Ax<b,
Aeq x = beq, [<x<u. There are even more constraints used in semi-infinite
programming; see “fseminf Problem Formulation and Algorithm” on page
4-39.

fmincon Trust Region Reflective Algorithm

Trust-Region Methods for Nonlinear Minimization

Many of the methods used in Optimization Toolbox solvers are based on trust
regions, a simple yet powerful concept in optimization.

To understand the trust-region approach to optimization, consider the
unconstrained minimization problem, minimize f(x), where the function takes
vector arguments and returns scalars. Suppose you are at a point x in n-space
and you want to improve, i.e., move to a point with a lower function value.
The basic idea is to approximate f with a simpler function q, which reasonably
reflects the behavior of function fin a neighborhood NV around the point x. This
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neighborhood is the trust region. A trial step s is computed by minimizing (or
approximately minimizing) over N. This is the trust-region subproblem,

min{q(s), se N}. (4-18)

The current point is updated to be x + s if f(x + s) < f(x); otherwise, the current
point remains unchanged and N, the region of trust, is shrunk and the trial
step computation is repeated.

The key questions in defining a specific trust-region approach to minimizing
f(x) are how to choose and compute the approximation g (defined at the
current point x), how to choose and modify the trust region N, and how
accurately to solve the trust-region subproblem. This section focuses on the
unconstrained problem. Later sections discuss additional complications due
to the presence of constraints on the variables.

In the standard trust-region method ([48]), the quadratic approximation ¢
1s defined by the first two terms of the Taylor approximation to F at x; the
neighborhood N is usually spherical or ellipsoidal in shape. Mathematically
the trust-region subproblem is typically stated

min {l sTHs+s” g such that | Ds| < A},
2 (4-19)

where g is the gradient of f at the current point x, H is the Hessian matrix
(the symmetric matrix of second derivatives), D is a diagonal scaling matrix, A
is a positive scalar, and || . || is the 2-norm. Good algorithms exist for solving
Equation 4-19 (see [48]); such algorithms typically involve the computation of
a full eigensystem and a Newton process applied to the secular equation

1_1_
A sl

Such algorithms provide an accurate solution to Equation 4-19. However,
they require time proportional to several factorizations of H. Therefore, for
large-scale problems a different approach is needed. Several approximation
and heuristic strategies, based on Equation 4-19, have been proposed in
the literature ([42] and [50]). The approximation approach followed in

4-21
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Optimization Toolbox solvers is to restrict the trust-region subproblem
to a two-dimensional subspace S ([39] and [42]). Once the subspace S
has been computed, the work to solve Equation 4-19 is trivial even if full
eigenvalue/eigenvector information is needed (since in the subspace, the
problem is only two-dimensional). The dominant work has now shifted to
the determination of the subspace.

The two-dimensional subspace S is determined with the aid of a
preconditioned conjugate gradient process described below. The solver defines
S as the linear space spanned by s, and s,, where s, is in the direction of the
gradient g, and s, is either an approximate Newton direction, i.e., a solution to

H-sy=-g, (4-20)
or a direction of negative curvature,
T
S9 'H'82 <0. (4-21)

The philosophy behind this choice of S is to force global convergence (via the
steepest descent direction or negative curvature direction) and achieve fast
local convergence (via the Newton step, when 1t exists).

A sketch of unconstrained minimization using trust-region ideas is now easy
to give:

1 Formulate the two-dimensional trust-region subproblem.
2 Solve Equation 4-19 to determine the trial step s.

3 If f(x + s) < f(x), thenx =x + s.

4 Adjust A.

These four steps are repeated until convergence. The trust-region dimension
A is adjusted according to standard rules. In particular, it is decreased if the
trial step is not accepted, i.e., f(x + s) > f(x). See [46] and [49] for a discussion
of this aspect.

Optimization Toolbox solvers treat a few important special cases of f with
specialized functions: nonlinear least-squares, quadratic functions, and linear
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least-squares. However, the underlying algorithmic ideas are the same as for
the general case. These special cases are discussed in later sections.

Preconditioned Conjugate Gradient Method

A popular way to solve large symmetric positive definite systems of linear
equations Hp = —g is the method of Preconditioned Conjugate Gradients
(PCG). This iterative approach requires the ability to calculate matrix-vector
products of the form H v where v is an arbitrary vector. The symmetric
positive definite matrix M is a preconditioner for H. That is, M = C?, where
C'HC'is a well-conditioned matrix or a matrix with clustered eigenvalues.

In a minimization context, you can assume that the Hessian matrix H is
symmetric. However, H is guaranteed to be positive definite only in the
neighborhood of a strong minimizer. Algorithm PCG exits when a direction of
negative (or zero) curvature is encountered, i.e., d’Hd < 0. The PCG output
direction, p, is either a direction of negative curvature or an approximate

(tol controls how approximate) solution to the Newton system Hp = —g. In
either case p is used to help define the two-dimensional subspace used in

the trust-region approach discussed in “Trust-Region Methods for Nonlinear
Minimization” on page 4-3.

Linear Equality Constraints

Linear constraints complicate the situation described for unconstrained
minimization. However, the underlying ideas described previously can be
carried through in a clean and efficient way. The large-scale methods in
Optimization Toolbox solvers generate strictly feasible iterates.

The general linear equality constrained minimization problem can be written
min{f(x) such that Ax =b}, (4-22)

where A is an m-by-n matrix (m < n). Some Optimization Toolbox solvers

preprocess A to remove strict linear dependencies using a technique based on

the LU-factorization of AT [46]. Here A is assumed to be of rank m.

The method used to solve Equation 4-22 differs from the unconstrained

approach in two significant ways. First, an initial feasible point x, is
computed, using a sparse least-squares step, so that Ax, = b. Second,

4-23
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Algorithm PCG is replaced with Reduced Preconditioned Conjugate Gradients
(RPCG), see [46], in order to compute an approximate reduced Newton step
(or a direction of negative curvature in the null space of A). The key linear
algebra step involves solving systems of the form

Lo} wa

where A approximates A (small nonzeros of A are set to zero provided rank is
not lost) and C is a sparse symmetric positive-definite approximation to H,
i.e., C = H. See [46] for more details.

c AT
A 0

Box Constraints
The box constrained problem is of the form

min{f(x) such that [ <x<u}, (4-24)

where [ 1s a vector of lower bounds, and u is a vector of upper bounds. Some
(or all) of the components of / can be equal to —o and some (or all) of the
components of u can be equal to . The method generates a sequence of
strictly feasible points. Two techniques are used to maintain feasibility while
achieving robust convergence behavior. First, a scaled modified Newton
step replaces the unconstrained Newton step (to define the two-dimensional
subspace S). Second, reflections are used to increase the step size.

The scaled modified Newton step arises from examining the Kuhn-Tucker
necessary conditions for Equation 4-24,

(D)2 g =0, (4-25)
where

D(x) = diag (|vk |_1/2 ) ,

and the vector v(x) is defined below, for each 1 <i < n:
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If g;<0and u; <o then v, = x;, — u,

12

Ifg,>0and /, > —o then v, =x, - [,

If g, <0and u; = o then v, =-1

Ifg,>0and [, = - then v, =1

The nonlinear system Equation 4-25 is not differentiable everywhere.
Nondifferentiability occurs when v, = 0. You can avoid such points by
maintaining strict feasibility, i.e., restricting [ < x < u.

The scaled modified Newton step s, for the nonlinear system of equations
given by Equation 4-25 is defined as the solution to the linear system

A
A

MDsY =-5 (4-26)

at the kth iteration, where

~ _ . 1/2

g:D 1g:dlag(|vl )g, (4_27)
and

M =D 'HD™! + diag(g)J"°. (4-28)

Here JJY plays the role of the Jacobian of |v|. Each diagonal component of the
diagonal matrix J° equals 0, —1, or 1. If all the components of [/ and u are
finite, J' = diag(sign(g)). At a point where g, = 0, v, might not be differentiable.

J}: =0 is defined at such a point. Nondifferentiability of this type is not a
cause for concern because, for such a component, it is not significant which
value v, takes. Further, |v,| will still be discontinuous at this point, but the
function |v;| g; is continuous.

Second, reflections are used to increase the step size. A (single) reflection
step is defined as follows. Given a step p that intersects a bound constraint,
consider the first bound constraint crossed by p; assume it is the ith bound
constraint (either the ith upper or ith lower bound). Then the reflection step
pf = p except in the ith component, where p¥, = —p,.
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fmincon Active Set Algorithm

Introduction

In constrained optimization, the general aim is to transform the problem
into an easier subproblem that can then be solved and used as the basis of
an iterative process. A characteristic of a large class of early methods is the
translation of the constrained problem to a basic unconstrained problem by
using a penalty function for constraints that are near or beyond the constraint
boundary. In this way the constrained problem is solved using a sequence

of parameterized unconstrained optimizations, which in the limit (of the
sequence) converge to the constrained problem. These methods are now
considered relatively inefficient and have been replaced by methods that
have focused on the solution of the Karush-Kuhn-Tucker (KKT) equations.
The KKT equations are necessary conditions for optimality for a constrained
optimization problem. If the problem is a so-called convex programming
problem, that is, f(x) and G,(x), i = 1,...,m, are convex functions, then the KKT
equations are both necessary and sufficient for a global solution point.

Referring to GP (Equation 4-1), the Kuhn-Tucker equations can be stated as

m
Vf(x*)+22,i-VGi(x*)=0
=1
A’i 'Gi (x*) = 0, 1= 1,...,me

A 20, i=m,+1,...,m, (4-29)
in addition to the original constraints in Equation 4-1.

The first equation describes a canceling of the gradients between the objective
function and the active constraints at the solution point. For the gradients to
be canceled, Lagrange multipliers (A, i = 1,...,m) are necessary to balance the
deviations in magnitude of the objective function and constraint gradients.
Because only active constraints are included in this canceling operation,
constraints that are not active must not be included in this operation and so
are given Lagrange multipliers equal to 0. This is stated implicitly in the last
two Kuhn-Tucker equations.

The solution of the KKT equations forms the basis to many nonlinear
programming algorithms. These algorithms attempt to compute the
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Lagrange multipliers directly. Constrained quasi-Newton methods guarantee
superlinear convergence by accumulating second-order information regarding
the KKT equations using a quasi-Newton updating procedure. These methods
are commonly referred to as Sequential Quadratic Programming (SQP)
methods, since a QP subproblem is solved at each major iteration (also known
as Iterative Quadratic Programming, Recursive Quadratic Programming, and
Constrained Variable Metric methods).

The 'active-set' algorithm is not a large-scale algorithm; see “Large-Scale
vs. Medium-Scale Algorithms” on page 2-45.

Sequential Quadratic Programming (SQP)

SQP methods represent the state of the art in nonlinear programming
methods. Schittkowski [36], for example, has implemented and tested a
version that outperforms every other tested method in terms of efficiency,
accuracy, and percentage of successful solutions, over a large number of test
problems.

Based on the work of Biggs [1], Han [22], and Powell ([32] and [33]), the
method allows you to closely mimic Newton’s method for constrained
optimization just as is done for unconstrained optimization. At each major
iteration, an approximation is made of the Hessian of the Lagrangian function
using a quasi-Newton updating method. This is then used to generate a QP
subproblem whose solution is used to form a search direction for a line search
procedure. An overview of SQP is found in Fletcher [13], Gill et al. [19],
Powell [35], and Schittkowski [23]. The general method, however, is stated
here.

Given the problem description in GP (Equation 4-1) the principal idea is the
formulation of a QP subproblem based on a quadratic approximation of the
Lagrangian function.

L(x,2) = f(x)+ Y % - g; ().
i=1 (4-30)

Here you simplify Equation 4-1 by assuming that bound constraints have

been expressed as inequality constraints. You obtain the QP subproblem by
linearizing the nonlinear constraints.
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Quadratic Programming (QP) Subproblem

N T
—d ' Hp,d+V d
min 5" Hid 9/ ()

T .
Vg (x,) d+gi(xp)=0, i=1,...,m,
T .
Vg (xg)" d+gi(x)<0, i=m, +1,....,m. (4-31)

This subproblem can be solved using any QP algorithm (see, for instance,
“Quadratic Programming Solution” on page 4-31). The solution is used to
form a new iterate

Xpo1 =%+ @y,

The step length parameter q,, is determined by an appropriate line search
procedure so that a sufficient decrease in a merit function is obtained (see
“Updating the Hessian Matrix” on page 4-29). The matrix H, is a positive
definite approximation of the Hessian matrix of the Lagrangian function
(Equation 4-30). H, can be updated by any of the quasi-Newton methods,
although the BFGS method (see “Updating the Hessian Matrix” on page 4-29)
appears to be the most popular.

A nonlinearly constrained problem can often be solved in fewer iterations
than an unconstrained problem using SQP. One of the reasons for this is
that, because of limits on the feasible area, the optimizer can make informed
decisions regarding directions of search and step length.

Consider Rosenbrock’s function with an additional nonlinear inequality
constraint, g(x),

X2 +x2 -1.5<0. (4-32)

This was solved by an SQP implementation in 96 iterations compared to 140
for the unconstrained case. SQP Method on Nonlinear Linearly Constrained
Rosenbrock’s Function (Eq. 3-2) on page 4-29 shows the path to the solution
point x = [0.9072,0.8228] starting at x = [-1.9,2.0].
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Figure 4-3: SQP Method on Nonlinear Linearly Constrained Rosenbrock’s
Function (Eq. 3-2)

SQP Implementation
The SQP implementation consists of three main stages, which are discussed
briefly in the following subsections:

e “Updating the Hessian Matrix” on page 4-29

® “Quadratic Programming Solution” on page 4-31

e “Line Search and Merit Function” on page 4-35

Updating the Hessian Matrix. At each major iteration a positive definite
quasi-Newton approximation of the Hessian of the Lagrangian function, H,

is calculated using the BFGS method, where A, i = 1,...,m, is an estimate
of the Lagrange multipliers.

T T.T
qrq Hy, s, spH,
Hyuq = Hy + 2250 R Rk
qr Sp Sp Hksk (4-33)

where
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Sk = Xp4+1 — Xp

g = Vf<xk+1>+§zi-Vgl-(xml)}[v;f(xk)é%-Vgl-<xk) |

i=1 i=1

Powell [33] recommends keeping the Hessian positive definite even though it
might be positive indefinite at the solution point. A positive definite Hessian

is maintained providing qgsk is positive at each update and that H is
initialized with a positive definite matrix. When qlz'sk is not positive, g, is

modified on an element-by-element basis so that qgsk > 0. The general aim
of this modification is to distort the elements of g,, which contribute to a

positive definite update, as little as possible. Therefore, in the initial phase
of the modification, the most negative element of q,*s, is repeatedly halved.

This procedure is continued until q;{sk is greater than or equal to a small

negative tolerance. If, after this procedure, qg sp, 1s still not positive, modify
q,, by adding a vector v multiplied by a constant scalar w, that is,

qr = qp Tt W, (4-34)
where

v; = ng (xk+1)-gi (xk+1)_Vgi (xk ) "8 (xk)
i (g <0 and (ay), (), <0, é=1,m

v; =0 otherwise,

and increase w systematically until q;?sk becomes positive.

The functions fmincon, fminimax, fgoalattain, and fseminf all use SQP.

If Display is set to 'iter' in options, then various information is given
such as function values and the maximum constraint violation. When the
Hessian has to be modified using the first phase of the preceding procedure to
keep it positive definite, then Hessian modified is displayed. If the Hessian
has to be modified again using the second phase of the approach described
above, then Hessian modified twice is displayed. When the QP subproblem
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1s infeasible, then infeasible is displayed. Such displays are usually not
a cause for concern but indicate that the problem is highly nonlinear and
that convergence might take longer than usual. Sometimes the message no

update is displayed, indicating that qgsk 1s nearly zero. This can be an
indication that the problem setup is wrong or you are trying to minimize a
noncontinuous function.

Quadratic Programming Solution. At each major iteration of the SQP
method, a QP problem of the following form is solved, where A, refers to the
ith row of the m-by-n matrix A.

min q(d) = lalTHd +cld,
deR" 2

Aidzbi’ i=1,...,me
Ad<b;, i=m,+1,..,m. (4-35)

The method used in Optimization Toolbox functions is an active set strategy
(also known as a projection method) similar to that of Gill et al., described
in [18] and [17]. It has been modified for both Linear Programming (LP) and
Quadratic Programming (QP) problems.

The solution procedure involves two phases. The first phase involves the
calculation of a feasible point (if one exists). The second phase involves the
generation of an iterative sequence of feasible points that converge to the

solution. In this method an active set, Ay, is maintained that is an estimate
of the active constraints (i.e., those that are on the constraint boundaries) at
the solution point. Virtually all QP algorithms are active set methods. This
point is emphasized because there exist many different methods that are very
similar in structure but that are described in widely different terms.

A,, is updated at each iteration k, and this is used to form a basis for a search
direction (;lk Equality constraints always remain in the active set A . The
notation for the variable c;fk is used here to distinguish it from d,, in the major

iterations of the SQP method. The search direction c;lk is calculated and
minimizes the objective function while remaining on any active constraint
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boundaries. The feasible subspace for cAlk is formed from a basis Z, whose

columns are orthogonal to the estimate of the active set A, (i.e., A,Z; =0).
Thus a search direction, which is formed from a linear summation of any
combination of the columns of Z,, is guaranteed to remain on the boundaries
of the active constraints.

The matrix Z, is formed from the last m — [ columns of the QR decomposition

of the matrix A;? , where [ is the number of active constraints and [ < m.
That is, Z, is given by

Z, =Q[:,1+1:m], (4-36)
where
TAT _ R
ean

Once Z, is found, a new search direction &k 1s sought that minimizes q(d)
where &k is in the null space of the active constraints. That is, &k is a linear

combination of the columns of Z,: &k =Zpp for some vector p.

Then if you view the quadratic as a function of p, by substituting for &k ,
you have

1
q(p) = —pTZZHka + cTka.

2 (4-37)

Differentiating this with respect to p yields
Vq(p)=ZL HZ,p+Z] c. (4-38)

Vq(p) is referred to as the projected gradient of the quadratic function because

it is the gradient projected in the subspace defined by Z,. The term ZkTHZk
is called the projected Hessian. Assuming the Hessian matrix H is positive
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definite (which is the case in this implementation of SQP), then the minimum
of the function g(p) in the subspace defined by Z, occurs when Vg(p) = 0,
which 1s the solution of the system of linear equations

ZFHZ,p=-ZF¢. (4-39)
A step is then taken of the form
Xpyl = X +a(2k, where czk = Z,Zp. (4-40)

At each iteration, because of the quadratic nature of the objective function,
there are only two choices of step length a. A step of unity along czk is the

exact step to the minimum of the function restricted to the null space of Ak .
If such a step can be taken, without violation of the constraints, then this

is the solution to QP (Equation 4-36). Otherwise, the step along &k to the
nearest constraint is less than unity and a new constraint is included in the
active set at the next iteration. The distance to the constraint boundaries in

any direction &k is given by

i{1,...,m} Azdk (4-41)

which is defined for constraints not in the active set, and where the direction

&k is towards the constraint boundary, i.e., Ai‘ik >0,1=1,...m.

When n independent constraints are included in the active set, without
location of the minimum, Lagrange multipliers, A,, are calculated that satisfy
the nonsingular set of linear equations

Al =c. (4-42)
If all elements of A, are positive, x, is the optimal solution of QP (Equation
4-36). However, if any component of A, is negative, and the component does

not correspond to an equality constraint, then the corresponding element is
deleted from the active set and a new iterate is sought.

4-33
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Initialization
The algorithm requires a feasible point to start. If the current point from the
SQP method is not feasible, then you can find a point by solving the linear

programming problem

min ¥ such that

yeR, xeR"
Aix=bl~, i=1,...,me
Ax—y<b, i=m,+1,...m. (4-43)

The notation A, indicates the ith row of the matrix A. You can find a feasible
point (if one exists) to Equation 4-43 by setting x to a value that satisfies
the equality constraints. You can determine this value by solving an under-
or overdetermined set of linear equations formed from the set of equality
constraints. If there is a solution to this problem, then the slack variable y is
set to the maximum inequality constraint at this point.

You can modify the preceding QP algorithm for LP problems by setting the
search direction to the steepest descent direction at each iteration, where g, is
the gradient of the objective function (equal to the coefficients of the linear
objective function).

dj, = ~ZyZf gy (4-44)

If a feasible point is found using the preceding LP method, the main QP phase

is entered. The search direction cAlk is initialized with a search direction &1
found from solving the set of linear equations

Hd; =-gj, (4-45)

where g, is the gradient of the objective function at the current iterate x,
(i.e., Hx, + ¢).

If a feasible solution is not found for the QP problem, the direction of search

for the main SQP routine a?k is taken as one that minimizes y.
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Line Search and Merit Function. The solution to the QP subproblem
produces a vector d,, which is used to form a new iterate

Xpt1 = Xp + Oldk. (4-46)

The step length parameter q,, is determined in order to produce a sufficient
decrease in a merit function. The merit function used by Han [22] and
Powell [33] of the following form is used in this implementation.

W@ = f@)+ 3@+ Y r-maxl0,g)l
i=1 i=m,+1 (4-47)

Powell recommends setting the penalty parameter

(rk)iTJr%}, i=1,..,m.

n = (e); = m?X{%, (1)

This allows positive contribution from constraints that are inactive in the

QP solution but were recently active. In this implementation, the penalty
parameter r, is initially set to

e

© Vel (4-49)
where | | represents the Euclidean norm.
This ensures larger contributions to the penalty parameter from constraints

with smaller gradients, which would be the case for active constraints at
the solution point.

fmincon Interior Point Algorithm

Barrier Function

The interior-point approach to constrained minimization is to solve a sequence
of approximate minimization problems. The original problem is

4-35



4 Using Optimization Toolbox™ Solvers

4-36

. . _ <
m;n f(x), subject to h(x) =0 and g(x) <O0. (4-50)

For each i > 0, the approximate problem is

min f, (x,s) = min f(x) — uZln(si ), subject to A(x) =0 and g(x) +s =0.
x,S Xx,S p (4-5 1)

There are as many slack variables s, as there are inequality constraints g.
The s, are restricted to be positive to keep In(s;,) bounded. As u decreases

to zero, the minimum of f, should approach the minimum of f. The added
logarithmic term is called a barrier function. This method is described in
[40], [41], and [51].

The approximate problem Equation 4-51 is a sequence of equality constrained
problems. These are easier to solve than the original inequality-constrained
problem Equation 4-50.

To solve the approximate problem, the algorithm uses one of two main types
of steps at each iteration:

e A direct step in (x, s). This step attempts to solve the KKT equations,
Equation 2-3 and Equation 2-4, for the approximate problem via a linear
approximation. This is also called a Newton step.

¢ A CG (conjugate gradient) step, using a trust region.
By default, the algorithm first attempts to take a direct step. If it cannot, it

attempts a CG step. One case where it does not take a direct step is when the
approximate problem is not locally convex near the current iterate.

At each iteration the algorithm decreases a merit function, such as

fo(x,8) +v|(h(x), g(x) +5)|.

The parameter v may increase with iteration number in order to force the
solution towards feasibility. If an attempted step does not decrease the merit
function, the algorithm rejects the attempted step, and attempts a new step.
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Direct Step
The following variables are used in defining the direct step:

® H denotes the Hessian of the Lagrangian of f,:

H=V )+ Vg () + Y A,V 7h;(x).
: 7 (4-52)

* J, denotes the Jacobian of the constraint function g.

® J, denotes the Jacobian of the constraint function 4.

e S = diag(s).

¢ ) denotes the Lagrange multiplier vector associated with constraints g
e A =diag(d).

® y denotes the Lagrange multiplier vector associated with A.

® ¢ denote the vector of ones the same size as g.

Equation 4-53 defines the direct step (Ax, As):

H o Jf J7|[ & Vf-Jdfy-Jda
0 SA 0 -S| as|_ SA— e
J, 0 I 0 |-a h

This equation comes directly from attempting to solve Equation 2-3 and
Equation 2-4 using a linearized Lagrangian.

In order to solve this equation for (Ax, As), the algorithm makes an LDL
factorization of the matrix. (See Example 4 — The Structure of D in the
MATLAB 1d1 function reference page.) This is the most computationally
expensive step. One result of this factorization is a determination of whether
the projected Hessian is positive definite or not; if not, the algorithm uses a
conjugate gradient step, described in the next section.
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Conjugate Gradient Step

The conjugate gradient approach to solving the approximate problem
Equation 4-51 is similar to other conjugate gradient calculations. In this
case, the algorithm adjusts both x and s, keeping the slacks s positive. The
approach is to minimize a quadratic approximation to the approximate
problem in a trust region, subject to linearized constraints.

Specifically, let R denote the radius of the trust region, and let other variables

be defined as in “Direct Step” on page 4-37. The algorithm obtains Lagrange
multipliers by approximately solving the KKT equations

VL=V, fx)+Y 4Vgx)+ Y, y;Vh;(x) =0,
i j

in the least-squares sense, subject to A being positive. Then it takes a step
(Ax, As) to approximately solve

min VAT Ax+ 2 AxTV2, LAx + ue” S 1As + = AsTS 1 Ans,

Ax,As 2 2 (4-54)
subject to the linearized constraints

8X) +JgAx+As =0, h(x)+JpAx=0. (4-55)

To solve Equation 4-55, the algorithm tries to minimize a norm of the
linearized constraints inside a region with radius scaled by R. Then Equation
4-54 is solved with the constraints being to match the residual from solving
Equation 4-55, staying within the trust region of radius R, and keeping s
strictly positive. For details of the algorithm and the derivation, see [40], [41],
and [51]. For another description of conjugate gradients, see “Preconditioned
Conjugate Gradient Method” on page 4-23.

Interior-Point Algorithm Options

Here are the meanings and effects of several options in the interior-point
algorithm.

® AlwaysHonorConstraints — When set to 'bounds', every iterate satisfies
the bound constraints you have set. When set to 'none"', the algorithm may
violate bounds during intermediate iterations.



Constrained Nonlinear Optimization

Hessian — When set to:

= 'user-supplied', pass the Hessian of the Lagrangian in a user-supplied
function, whose function handle must be given in the option HessFcn.

= 'bfgs', fmincon calculates the Hessian by a dense quasi-Newton
approximation.

= 'lbfgs', fmincon calculates the Hessian by a limited-memory,
large-scale quasi-Newton approximation.

= 'fin-diff-grads', fmincon calculates a Hessian-times-vector product
by finite differences of the gradient(s); other options need to be set
appropriately.

You can also give a separate function for Hessian-times-vector. See
“Hessian” on page 9-41 for more details on these options.

InitBarrierParam — The starting value for p. By default, this is 0.1.

ScaleProblem — When set to 'obj-and-constr', the algorithm works
with scaled versions of the objective function and constraints. It carefully
scales them by their initial values. Disable scaling by setting ScaleProblem
to 'none’.

SubproblemAlgorithm — Determines whether or not to attempt the direct
Newton step. The default setting '1d1-factorization' allows this type of
step to be attempted. The setting 'cg' allows only conjugate gradient steps.

For a complete list of options see “Interior-Point Algorithm” on page 9-50.

fminbnd Algorithm

fminbnd is a solver available in any MATLAB installation. It solves for a local
minimum in one dimension within a bounded interval. It is not based on
derivatives. Instead, it uses golden-section search and parabolic interpolation.

fseminf Problem Formulation and Algorithm

fseminf Problem Formulation

fseminf addresses optimization problems with additional types of constraints
compared to those addressed by fmincon. The formulation of fmincon is
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min f(x)

such that c¢(x) <0, ceq(x)=0, Ax<b, Aeqx=beq, andl<x<u.

fseminf adds the following set of semi-infinite constraints to those already
given. For w; in a one- or two-dimensional bounded interval or rectangle I, for
a vector of continuous functions K(x, w), the constraints are

K(x, w;) <0 for all w; I..

The term “dimension” of an fseminf problem means the maximal dimension of
the constraint set I: 1 if all IJ are intervals, and 2 if at least one IJ is a rectangle.
The size of the vector of K does not enter into this concept of dimension.

The reason this is called semi-infinite programming is that there are a finite
number of variables (x and wj), but an infinite number of constraints. This

1s because the constraints on x are over a set of continuous intervals or
rectangles Ij, which contains an infinite number of points, so there are an
infinite number of constraints: Kj(x, wj) < 0 for an infinite number of points w.

You might think a problem with an infinite number of constraints is
impossible to solve. fseminf addresses this by reformulating the problem to
an equivalent one that has two stages: a maximization and a minimization.
The semi-infinite constraints are reformulated as

max K ;(x,w;) <0 for allj =1,...,|K|,
w;el; (4-56)

where | K| is the number of components of the vector K; i.e., the number
of semi-infinite constraint functions. For fixed x, this is an ordinary
maximization over bounded intervals or rectangles.

fseminf further simplifies the problem by making piecewise quadratic or
cubic approximations ;cj(x, wj) to the functions Kj(x, wj), for each x that the
solver visits. fseminf considers only the maxima of the interpolation function
Kj(x, wj), instead of Kj(x, wj), in Equation 4-56. This reduces the original
problem, minimizing a semi-infinitely constrained function, to a problem
with a finite number of constraints.
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Sampling Points. Your semi-infinite constraint function must provide
a set of sampling points, points used in making the quadratic or cubic
approximations. To accomplish this, it should contain:

® The initial spacing s between sampling points w

* A way of generating the set of sampling points w from s

The initial spacing s is a | K|-by-2 matrix. The jth row of s represents the
spacing for neighboring sampling points for the constraint function K. If
Kj depends on a one-dimensional w;, set s(j,2) = 0. fseminf updates the
matrix s in subsequent iterations.

fseminf uses the matrix s to generate the sampling points w, which it then
uses to create the approximation Kj(x, wj). Your procedure for generating w
from s should keep the same intervals or rectangles [, during the optimization.

Example of Creating Sampling Points. Consider a problem with two
semi-infinite constraints, K; and K,. K, has one-dimensional w;, and K,
has two-dimensional w,. The following code generates a sampling set from
w, =2 to 12:

% Initial sampling interval
if isnan(s(1,1))

s(1,1) = .2;

s(1,2) = 0;
end

% Sampling set
wl = 2:s8(1,1):12;

fseminf specifies s as NaN when it first calls your constraint function.
Checking for this allows you to set the initial sampling interval.

The following code generates a sampling set from w, in a square, with each
component going from 1 to 100, initially sampled more often in the first
component than the second:

% Initial sampling interval

if isnan(s(1,1))
s(2,1) = 0.2;
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s(2,2) = 0.5;
end

% Sampling set

w2x = 1:s5(2,1):100;

w2y 1:5(2,2):100;

[wx,wy] = meshgrid(w2x,w2y);

The preceding code snippets can be simplified as follows:

% Initial sampling interval
if isnan(s(1,1))

s = [0.2 0;0.2 0.5];
end

% Sampling set

wl = 2:5(1,1):12;

w2x = 1:5(2,1):100;

w2y = 1:5(2,2):100;

[wx,wy] = meshgrid(w2x,w2y);

fseminf Algorithm

fseminf essentially reduces the problem of semi-infinite programming to a
problem addressed by fmincon. fseminf takes the following steps to solve

semi-infinite programming problems:

1 At the current value of x, fseminf identifies all the w;; such that the
interpolation ;cj(x, wj,i) is a local maximum. (The maximum refers to

varying w for fixed x.)

2 fseminf takes one iteration step in the solution of the fmincon problem:

min f(x)

and [ <x < u, where

such that c¢(x) <0, ceq(x)=0, Ax<b, Aeqx=beq,
c(x) is augmented with all the maxima of K (x, w)) taken over all w; I, which

1s equal to the maxima over j and i of x(x, w; ).
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3 fseminf checks if any stopping criterion is met at the new point x (to halt
the iterations); if not, it continues to step 4.

4 fseminf checks if the discretization of the semi-infinite constraints needs
updating, and updates the sampling points appropriately. This provides an
updated approximation }cj(x, wj). Then it continues at step 1.
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Constrained Nonlinear Optimization Examples

In this section...

“Example: Nonlinear Inequality Constraints” on page 4-44
“Example: Bound Constraints” on page 4-46
“Example: Constraints With Gradients” on page 4-47

“Example: Constrained Minimization Using fmincon’s Interior-Point
Algorithm With Analytic Hessian” on page 4-50

“Example: Equality and Inequality Constraints” on page 4-57

“Example: Nonlinear Minimization with Bound Constraints and Banded
Preconditioner” on page 4-58

“Example: Nonlinear Minimization with Equality Constraints” on page 4-62

“Example: Nonlinear Minimization with a Dense but Structured Hessian
and Equality Constraints” on page 4-64

“Example: One-Dimensional Semi-Infinite Constraints” on page 4-68

“Example: Two-Dimensional Semi-Infinite Constraint” on page 4-70

Example: Nonlinear Inequality Constraints

If inequality constraints are added to Equation 4-16, the resulting problem
can be solved by the fmincon function. For example, find x that solves

. :x142+22+4 +2 +1).
m;nf(x) e ( X1 +4aXg +4X X9 + 4Xg ) (4-57)

subject to the constraints

XXy — X — Xy <—1.5,
x,%, > —10.

Because neither of the constraints is linear, you cannot pass the constraints
to fmincon at the command line. Instead you can create a second M-file,
confun.m, that returns the value at both constraints at the current x in a
vector ¢. The constrained optimizer, fmincon, is then invoked. Because
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fmincon expects the constraints to be written in the form c(x) < 0, you must
rewrite your constraints in the form

XXy — %, — %, +1.5<0,
—x,x, —10 < 0. (4-58)

Step 1: Write an M-file objfun.m for the objective function.

function f = objfun(x)
f = exp(x(1))*(4*x(1)72 + 2*x(2)"2 + 4*x(1)*x(2) + 2*x(2) + 1);

Step 2: Write an M-file confun.m for the constraints.

function [c, ceq] = confun(x)

% Nonlinear inequality constraints

c =[1.5+ x(1)*x(2) - x(1) - x(2);
-x(1)*x(2) - 10];

% Nonlinear equality constraints

ceq = [];

Step 3: Invoke constrained optimization routine.

x0 = [-1,1]; % Make a starting guess at the solution
options = optimset('Algorithm','active-set');
[x,fval] =

fmincon(@objfun,x0,[1,[1,[1,[]1,[1,[1,@confun,options)

After 38 function calls, the solution x produced with function value fval is
X =
-9.5474 1.0474

fval =
0.0236

You can evaluate the constraints at the solution by entering
[c,ceq] = confun(x)
